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MODBUS SIO Master Driver

Introduction
This manual describes how to connect the Display and the External Device (target PLC).
In this manual, the connection procedure will be described by following the below sections:

1 || System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

&g System Configuration" (page 3)

2 Selection of External Device =
Select a model (series) of the External
Device to be connected and connection
method.

"2 Selection of External Device" (page 9)

3 Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

&3 Example of Communication Setting"
(page 10)

4 Setup ltems

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro Ex or in offline mode.

Fny Setup Items" (page 46)

5 || Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

&5 Cable Diagram” (page 54)

Operation
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MODBUS SIO Master Driver

1 System Configuration
The system configuration in the case when the External Device and the Display are connected is shown.
11 Schneider Electric SA External Device.
. . SIO . .
Series CPU Link I/F Tpe Setting Example Cable Diagram
TSX 37 05 028DR1 Setting Example 1 | Cable Diagram 2
TSX 3708 056DR1 | |0 Porton CPU RS232C | (hage 10) (page 66)
TSX 37 10 128DT1
TSX 37 10 128DR1
TSX 3710 128DTK1 Accessory box RS485 | Setting Example 3 | Cable Diagram 3
TSX 3710 164DTK1 | T5x sCA 50 (2wire) | (page 14) (page 67)
TSX 37 10 028AR1
TSX 37 10 028DR1
Micro TER port on CPU RS232C Setting Example 1 | Cable Diagram 2
(page 10) (page 66)
TSX 37 21 101 Accessory box RS485 | Setting Example 3 | Cable Diagram 3
TSX 37 22 101 TSX SCA 50 (2wire) | (page 14) (page 67)
TSX 3721001 PCMCIA card for RS232C RS232C Setting Example 2 | Cable Diagram 4
TSX 3722001 TSX SCP 111 (page 12) (page 80)
PCMCIA card for RS485 | RS485 | Setting Example 3 | Cable Diagram 5
TSX SCP 114 (2wire) | (page 14) (page 84)
TSX P57 103M PCMCIA card for RS232C RS232C Setting Example 4 | Cable Diagram 4
TSX P57 153M TSX SCP 111 (page 16) (page 80)
TSX P57 203M
Premium TSX P57 253M ) )
TSX P57 303M PCMCIA card for RS485 | RS485 | Setting Example 5 | Cable Diagram 5
TSX P57 353M TSX SCP 114 (2wire) | (page 18) (page 84)
TSX P57 453M
TWD LCAA 10DRF . .
TWD LCAA 16DRF | Programming port on CPU | RS232C (Si“'e”go)Examp'e 6 E:zb'eeG'g)'agram 2
TWD LCAA 24DRF pag pag
TWD LMDA 20DTK
Twido TWD LMDA
20DUK
TWD LMDA 20DRT | TWD NAC 485T RS485 Setting Example 7 | Cable Diagram 1
TWD LMDA 40DTK (2wire) | (page 22) (page 54)
TWD LMDA
40DUK
140 CPU 113 02
Quantum 140 CPU 113 03 Modbus port on CPU RS232C Setting Example 8 | Cable Diagram 6

140 CPU 434 12A
140 CPU 534 14A

(page 24)

(page 96)
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MODBUS SIO Master Driver

SIO
Series CPU Link I/F Type Setting Example Cable Diagram
171 CCS 700 00
171 CCS 700 10 Setting Example 9 | Cable Diagram 7
171 CCS 760 00 Modbus port 1 on CPU RS232C (page 26) (page 98)
171 CCC 760 10
Setting Example 9 | Cable Diagram 7
Modbus port 1 on CPU RS232C
Momentum 421 ~cs 780 00 P (page 26) (page 98)
171 CCC 780 10 ; ;
Modbus port 2 on CPU RS4&_35 Setting Example Cable Diagram 8
(4wire) | 10 (page 28) (page 99)
171 CCC 980 20 RS485 | Setting Example Cable Diagram 8
171 CCC 980 30 Modbus port 2 on CPU (4wire) | 10 (page 28) (page 99)

B Connection Configuration

® Micro Series

e 1:1 Connection

TER port—_

PCMCIA—

—hod

@ Premium Series

e 1:1 Connection

TER port

=

o)
O
0

PCMCIA—

—I&00

0 Accessory box
TSX SCA50
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MODBUS SIO Master Driver

@ Twido Series

¢ 1:1 Connection

External Device

Programming port
or

Extension port —bo

TWDNAC485T /

¢ 1:n Connection

Max 16 units
A
e A
(0] o
Extension port—p® %

TWDNAC485T

€ Quantum Series

¢ 1:1 Connection

&

Modbus P

port on CPU
4 Momentum Series
¢ 1:1 Connection
Modbus port
3

*Port specification varies
depending on the model.

|
|
|
|
-
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MODBUS SIO Master Driver

1.2 Yokogawa Electric Corporation External Devices.
. . SIO . .
Series CPU Link I/F Te Setting Example Cable Diagram
. Setting Example Cable Diagram 9
Serial port on CPU RS232C 11 (page 30) (page 104)
i Setting Example Cable Diagram
NFLR111-S00 RS232C 12 (page 34) 10 (page 106)
FCN NFCP100-S00
RS485 | Setting Example Cable Diagram
(4 wire) | 13 (page 38) 11 (page 108)
NFLR121-S00
RS485 | Setting Example Cable Diagram
(2 wire) | 14 (page 42) 12 (page 115)
FCJ NFJT100-5100 Serial port on CONTROL RS232C Setting Example Cable Diagram 9

UNIT

11 (page 30)

(page 104)

B Connection Configuration

@ FCN/FCJ Series

1:1 Connection

1:n Connection

GP-Pro EX Device/PLC Connection Manual 6




B |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

MODBUS SIO Master Driver

Usable port
) Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)
com1™, comz,
PS-2000B Com3*L coma - .
PS-3450A, PS-3451A, o * qxp
PS3000-BA, PS3001-BD COMIL, COM2 com2 com2
PS-3650A (T41 model), 1 ] ]
PS-3651A (T41 model) coMl
PS-3650A (T42 model), % % e
PS-3651A (T42 model) com1™t*2 com2 COM1 CcCoM1
PS-3700A (Pentium®4-M) | coM1™, com2™, o "
PS-3710A COM3™2, coM4 com3 CoM3
PS-3711A comM1™ com2™ CoM2™2 COM2*?
PS4000™3 COM1, COM2 - -
com1™2 com2™, 1% %
PL3000 COM3, COM4 coM1 CcCoM1

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

DIP Switch setting: RS-232C

DIP Switch Setting Description
1 OFF™1 Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

GP-Pro EX Device/PLC Connection Manual 7



MODBUS SIO Master Driver

DIP Switch setting: RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON

GP-Pro EX Device/PLC Connection Manual 8



MODBUS SIO Master Driver

2 Selection of External Device

Select the External Device to be connected to the Display.

#* Welcome to GP-Pro EX B3
4 Device/PLC
» evice,
GP-Prolz ! |

Mumber of Devices/PLCs |1 3: ‘g
Device/PLC 1

Manufacturer | Schneider Electric S& |L

Series MODBUS 510 Master [+

Fart COM1 [+
Eefer to the manual of this Device/PLC
Eecent Device/PLC

4 L

I Use Spstem Area Drevice Information

Back [B] | Communication Settings Mew Logic | Mew Screen I Cancel

Setup Items Setup Description

Number of Devices/ Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

PLCs

Manufacturer Select the manufacturer of the External Device to connect. Select "Schneider Electric SA".
Select the External Device model (series) and the connection method. Select "MODBUS SI10
Master".

Series In System configuration, make sure the External Device you are connecting is supported by
"MODBUS SIO Master".

& System Configuration" (page 3)
Port Select the Display port to connect to the External Device.

Check this option to synchronize the system data area of the Display and the device (memory)
of the External Device. When synchronized, you can use the External Device’s ladder program
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area]

Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"”

Use System Area

GP-Pro EX Device/PLC Connection Manual 9



MODBUS SIO Master Driver

3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are
shown.

3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |Schneider Electic 54 Series MODEUS 510 taster Part  |COM1
Text Data Mode ’T LChange

Communication Settings

510 Type f+ RS232C (" RS5422/485(2wire) (" RS422/485(4wire)
Speed 9600 =

Data Length 7 (O]

Parity " MOME + EVEM " 0DD

Stop Bit 1 2

Flaws Cantral {+ MOME " ER[DTR/CTS) -

Timeout m [zec)

Fietry m

Wait To Send m [mis] v Default Value

Rl #%WCC + Rl " YCC

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C

Isolation Unit, please select it to WCC. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 |F'LEI‘I E |Slave Equipment Address=1 Fest of the bits in this wol

GP-Pro EX Device/PLC Connection Manual 10



MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 1008 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program writes data to Holding Register during the Discrete Input [1] Read [02H] 1008 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] B3 3: words

Holding Register (4]  Read [03H)] B3 3: words
Holding Register [4]  Wite [10H] Bl 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

W Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration” from "Configuration™ in "Application Browser" of "PL7 PRO". Next,
double-click "Comm®" in the "Configuration” dialog box. Perform the settings in the displayed dialog box.

Setup Iltems Setup Description

CHANNEL 0

CHANNEL
MODBUS/JBUS LINK MAST

Slave number 1

Transmission speed 9600bps

Delay between characters 5msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

* Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 11



MODBUS SIO Master Driver
|

3.2 Setting Example 2
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 12



MODBUS SIO Master Driver

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 1008 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program writes data to Holding Register during the Discrete Input [1] Read [02H] 1008 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] B3 3: words

Holding Register (4]  Read [03H)] B3 3: words
Holding Register [4]  Wite [10H] Bl 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration” from "Configuration™ in "Application Browser" of "PL7 PRO". Next,
double-click "Comm®" in the "Configuration” dialog box. Perform the settings in the displayed dialog box.

Setup Iltems Setup Description

CHANNEL 1

CHANNEL TSX SCP 111 RS232 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 13



MODBUS SIO Master Driver
|

3.3 Setting Example 3
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 14



MODBUS SIO Master Driver

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 1008 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program writes data to Holding Register during the Discrete Input [1] Read [02H] 1008 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] B3 3: words

Holding Register (4]  Read [03H)] B3 3: words
Holding Register [4]  Wite [10H] Bl 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration” from "Configuration™ in "Application Browser" of "PL7 PRO". Next,
double-click "Comm®" in the "Configuration” dialog box. Perform the settings in the displayed dialog box.

Setup Iltems Setup Description

CHANNEL 1

CHANNEL TSX SCP 114 RS485 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 15



MODBUS SIO Master Driver
|

3.4 Setting Example 4
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 16



MODBUS SIO Master Driver

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 1008 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program writes data to Holding Register during the Discrete Input [1] Read [02H] 1008 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] B3 3: words

Holding Register (4]  Read [03H)] B3 3: words
Holding Register [4]  Wite [10H] Bl 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration” from "Configuration™ in "Application Browser" of "PL7 PRO". Next,

double-click "Comm®" in the "Configuration” dialog box. Perform the settings in the displayed dialog box.

Setup Iltems Setup Description

CHANNEL 1

CHANNEL TSX SCP 111 RS232 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

» Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 17



MODBUS SIO Master Driver
|

3.5 Setting Example 5
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 18



MODBUS SIO Master Driver

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 1008 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program writes data to Holding Register during the Discrete Input [1] Read [02H] 1008 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] B3 3: words

Holding Register (4]  Read [03H)] B3 3: words
Holding Register [4]  Wite [10H] Bl 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration” from "Configuration™ in "Application Browser" of "PL7 PRO". Next,

double-click "Comm®" in the "Configuration” dialog box. Perform the settings in the displayed dialog box.

Setup Iltems Setup Description

CHANNEL 1

CHANNEL TSX SCP 114 RS485 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 19
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|
3.6 Setting Example 6
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

g
g
g

GP-Pro EX Device/PLC Connection Manual 20



@ Device Setting

MODBUS SIO Master Driver

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab

[Max Query] tab

@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
E quipment Configuration ] Max Query | Equipment Corfiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Coil (0] Read (01H] 2000 = bits
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits
Mote on when selecting Do not clear : 5 — .
If the ladder program writes data to Holding Register during the Discrete Input [1] Read [02H] 2000 = bits
read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] 125 3: words
[~ IECE1131 Spnt.
priaK Halding Register (4] Read (03H) 125 =] weords
Address Mode
Holding Register (4] write [10H 3‘ words
Fleaze reconfirm all of address settings that pou are using if you By o (10H] 100 =
have changed the setting.
[~ Single Bit manipulation to Coil/Discrete |nput
W ariables
Double ‘Word word order Lo word first{L/H] -
™ Low Security Level
Default Default
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "TwidoSoft" for communication settings.
Select "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft", and right-click on
"Port 1 : Remote Link, 1" to select "Edit Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Setup ltems Setup Description

Type Modbus
Protocol

Address 1

Baud Rate 19200

Data Bits 8
Parameters -

Parity None

Stop Bits 1
End of Frame 10
Response Timeout 10 x 100msec
Frame Timeout 4msec

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 21



MODBUS SIO Master Driver
|

3.7 Setting Example 7
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 22
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program wites data to Holding Register during the Discrete Input [1] Read [02H] 2000 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] 125 3: words

Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "TwidoSoft" for communication settings.
Right-click on "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft" to select "Add
Option...". Right-click on "Port 2 : Modbus, 1" added to "Hardware" in "TWDLMDA40DUK" to select "Edit
Controller Comm Setup...".
Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Setup ltems Setup Description

Type Modbus
Protocol

Address 1

Baud Rate 19200

Data Bits 8
Parameters

Parity None

Stop Bits 1
End of Frame 10
Response Timeout 10 x 100msec
Frame Timeout 10msec

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.8 Setting Example 8
W Settings of GP-Pro EX
4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

sl
g
g

—

GP-Pro EX Device/PLC Connection Manual 24



MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program wites data to Holding Register during the Discrete Input [1] Read [02H] 2000 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] 125 3: words

Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "Concept" for communication settings.
After selecting the External Device in Quantum Series in "PLC Selection" of "Concept", select "Modbus Port

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Setup ltems Setup Description

Baud 19200
Data Bits 8
Stop Bits 1
Parity Even
Delay(ms) 10
Address 1
Head slot 0
Mode RTU
Protocol RS232

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.9 Setting Example 9
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 26



MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program wites data to Holding Register during the Discrete Input [1] Read [02H] 2000 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] 125 3: words

Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "Concept" for communication settings.
After selecting the External Device in Momentum Series in "PLC Selection™ of "Concept", select "Modbus Port

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Setup ltems Setup Description

Baud 19200
Data Bits 8
Stop Bits 1
Parity Even
Delay(ms) 10
Address 1
Head slot 0
Mode RTU
Protocol RS232

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.10 Setting Example 10
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program wites data to Holding Register during the Discrete Input [1] Read [02H] 2000 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] 125 3: words

Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "Concept" for communication settings.
After selecting the External Device in Momentum Series in "PLC Selection™ of "Concept", select "Modbus Port

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Setup ltems Setup Description

Baud 19200
Data Bits 8
Stop Bits 1
Parity Even
Delay(ms) 10
Address 1
Head slot 0
Mode RTU
Protocol RS485

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.11 Setting Example 11
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear' : ) — .
If the ladder program wites data to Holding Register during the Discrete Input [1] Read [02H] 2000 = bits

read/write process, the resulting data may be incorrect.
Input Register (3] Fiead [04H] 125 3: words

Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device

Use the Web browser and ladder software (Logic Designer) for communication settings.

<Communication Settings for the Serial Port on CPU>
1 Set IP address of the External Device to "192.168.1.1".

NOTE « For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings (Resource Configurator).

2 Connect both the Ethernet ports between a PC and the External Device using the LAN cable. (Connect via HUB.)
3 Start up the Web browser.
4 Enter "http://192.168.1.1/mnt" in the address input box.
5 Enter [User Name] and [Password] in the displayed dialog box to login.
6 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.
7 Click [Reboot] to display the [Reboot FCX] screen.
8 Check the [Reboot(Maintenance Mode)] option.
9 Click [OK] to display the [Reboot] screen.
10 Reboot the External Device. Confirm the reboot is complete.
11 click [Maintenance Homepage] to display the [STARDOM FCX Maintenance Page] screen.
12 Click [OK] to display the [FCX Maintenance Menu] screen.
13 click [Edit] to display the [Edit System Setting Files] screen.
14 Check the [COML1 Port Setting File] option and click [OK].
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15 Set each item as follows:

Setup Items Setup Description
Baudrate 19200
DataBitLength 8
StopBitLength 1
Parity EVEN

16 Click [OK] to display the [Edit System Setting Files(RESULT)] screen.
17 Click [Maintenance Menul] to display the [FCX Maintenance Menu] screen.

18 Click [Reboot] to display the [Reboot FCX] screen.

19 Check the [Reboot(Online Mode)] option and click [OK].

The External Device is rebooted.

<Control Logic Download Procedures>

1 Start up the ladder software.
2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

example of control logic, refer to "4 Control Logic Example”.

& n

@ Control Logic Example" (page 33)

MODBUS SIO Master Driver

3 Double-click [COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

O Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.
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@ Control Logic Example

To connect the Display to the External Device, the control logic is required.
The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR —RTU_ERROR1
. — OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION

COIL— COIL COIL COIL
DSCI—- DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG— HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1
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3.12 Setting Example 12
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 34



MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear :
If the ladder program writes data to Holding Register during the
read/write process, the resulting data may be incorrect.

Dizcrete Input (1] Fiead [02H] 2000 = bits

Input Register (3] Fiead [04H] 125 3: words
Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

NOTE » For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings.

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.
4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.
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O Set specifications as follows:

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex
Baud Rate 19200
Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control | NONE

API Error Detection YES

10 Download the communication settings to the External Device.
11 Reboot the External Device.

<Control Logic Download Procedures>
1 Start up the ladder software.
2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

example of control logic, refer to "4 Control Logic Example”.

5" ¢ Control Logic Example" (page 37)

3 Double-click [[COM1'] next to [PORT] to display the [Variable Properties] dialog box.
4 Enter the connecting port name in [Name], and click [OK].
5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.
6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.
8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.
9 Enter "192.168.1.1" in [Host Name/IP Address].
10 click [OK].
11 Download the communication settings to the External Device.
12 Reboot the External Device.
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@ Control Logic Example
To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR —RTU_ERRORI1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01"'— REVISION

COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG— HREG HREG +—HREG
ESTS— ESTS ESTS —ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1
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3.13 Setting Example 13
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear :
If the ladder program writes data to Holding Register during the
read/write process, the resulting data may be incorrect.

Dizcrete Input (1] Fiead [02H] 2000 = bits

Input Register (3] Fiead [04H] 125 3: words
Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

NOTE » For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings.

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.
4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.
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O Set specifications as follows:

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex
Baud Rate 19200
Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control | NONE

API Error Detection YES

10 Download the communication settings to the External Device.
11 Reboot the External Device.

<Control Logic Download Procedures>
1 Start up the ladder software.
2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

example of control logic, refer to "4 Control Logic Example”.

5" ¢ Control Logic Example" (page 41)

3 Double-click [[COM1'] next to [PORT] to display the [Variable Properties] dialog box.
4 Enter the connecting port name in [Name], and click [OK].
5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.
6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.
8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.
9 Enter "192.168.1.1" in [Host Name/IP Address].
10 click [OK].
11 Download the communication settings to the External Device.
12 Reboot the External Device.
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To connect the Display to the External Device, the control logic is required.
The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR —RTU_ERROR1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION

COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG— HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1—- COMERR — COMERR +— RTU_COMERR1
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3.14 Setting Example 14
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
@* Individual Device Settings @* Individual Device Settings
PLCI PLCY
Equipment Canfiguratian ] [ Querv] Equipment Confiquration  Max Query ]
Equipment Address
Slave Equipment Address 1 3: Address Function Codes I ax Query
Bit manipulation [set/reset] to Holding Register Cail (0] Read [01H] 2000 = hitz
Rest of the bits in this word " Clear {+ Da nat clear Coil (0] Wwiite (OFH) o0 =1 bits

Mote on when selecting Do not clear :
If the ladder program writes data to Holding Register during the
read/write process, the resulting data may be incorrect.

Dizcrete Input (1] Fiead [02H] 2000 = bits

Input Register (3] Fiead [04H] 125 3: words
Holding Register (4]  Read [03H)] 125 3: words
Holding Register [4]  Wite [10H] 100 3: words

[~ Single Bit manipulation to Coil/Discrete |nput

I~ IECE1131 Syntax

Address Mode

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

W ariables
Double ‘Word word order Lo word first{L/H] -

™ Low Security Level

Drefault Drefault
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

NOTE | ¢ For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings.

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.
4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

GP-Pro EX Device/PLC Connection Manual 43



MODBUS SIO Master Driver

O Set specifications as follows:

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex
Baud Rate 19200
Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control | NONE

API Error Detection YES

10 Download the communication settings to the External Device.
11 Reboot the External Device.

<Control Logic Download Procedures>
1 Start up the ladder software.
2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

example of control logic, refer to "4 Control Logic Example”.

5" ¢ Control Logic Example" (page 45)

3 Double-click [[COM1'] next to [PORT] to display the [Variable Properties] dialog box.
4 Enter the connecting port name in [Name], and click [OK].
5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.
6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.
8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.
9 Enter "192.168.1.1" in [Host Name/IP Address].
10 click [OK].
11 Download the communication settings to the External Device.
12 Reboot the External Device.
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To connect the Display to the External Device, the control logic is required.
The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR —RTU_ERROR1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0 — TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION

COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG |—IREG
HREG— HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1
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MODBUS SIO Master Driver

Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

& n

4.1

3 Example of Communication Setting" (page 10)

Setup Items in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |

Summary Change Device/PLC
M anufacturer |Schneider Electic 54 Series MODEUS 510 taster Part  |COM1

Text Data Mode ’T Change

Communication Settings
SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 19200 =
Data Length 7 (O]
Parity " NOME + EVEM " ooD
Stop Bit 1 2
Flow Contral (+ NOME " ER[DTR/CTS) -
Timeout m [zec)
Fietry m

Wait To Send 3 3: [mz) v Default alue

Rl /%CC Rl " WCC

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C

Isolation Unit, please select it to WCC. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device

1 |F'LEI‘I E |Slave Equipment Address=1 Fest of the bits in this wol

Setup Items Setup Description

SIO Type

Select the SI0 type to communicate with the External Device.

Speed

Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
. Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.
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Setup ltems Setup Description

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.
When the check box of the default value is checked, the Wait To Send value automatically

changes in the formula below by changing each value for Speed/Data Length/Parity/Stop

Bit.
Wait To Send (ms) = 3500 x (1 + Data Length + Stop Bit + Parity)
Speed (bps)
Wait To Send Value for the parity setting is shown below.
No Parity =0
Parity Even =1
Parity Odd = 1

 After changing the Wait To Send value for the project, of which [Default Value] is
checked, in the offline mode, the Wait To Send value will be recalculated when the
project is received and communication settings are displayed.

You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE | * Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf.  GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab

|i: Individual Device Settines

PLC1

Equipment Configuration | ax Quewl

— Equipment Address
Slave Equipment Address I 1 3:

—Bit manipulation [zet/rezet] to Holding Register
Rest of the bits in this word " Clear & Do not clear

Mote on when selecting Do not clear :
If the ladder program writes data to Holding Register during the
read/write process, the resulting data may be incorrect.

T IECE1131 Syrtax
Address Mode ID-based [Default] LI

Fleaze reconfirm all of address settings that pou are using if you
have changed the setting.

—Waniables
Double ‘Word word order Lo word first{L/H] LI

™ Low Security Level

D efault |
oK@ | Cancel |

Setup Items Setup Description

Use an integer from 1 to 247 to enter the slave equipment address of the

Slave Equipment Address External Device.

Bit manipulation (set / reset) to

Holding Resister From "Clear" or "Do not clear", select treatment of the rest of the bits in the
Rest of the bits in | S8me word when the bit manipulation to Holding Register is performed.

this word

Check this item when you use the IEC61131 syntax for variables. In case that

IEC61131 Syntax you check on, select Address Mode, [0-based] or [1-based].

Select the order of storing double word data from "Low word first" or "High

Double Word word order S
word first".

Low Security Level Put a check when lowering the format check level.
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[Max Query] tab

|i: Individual Device Settines

PLC1

Equipment Confiquration  Max Query |

Address Function Codes I ax Query

Coil (0) Read (0TH) [2000 =] bits
Cail 0] ‘W (OFH) 500 =] tits
Discrete Input (1) Read (02H) [2000 =] bits
Input Register (3] Fiead [04H] lﬂ words
Holding Register (4] Read (03H) 125 =] wards
Holding Register [4]  Wite [10H] 100 = words

™ Single Bit manipulation to Coil/Discrete Input

D efault |
oK@ | Cancel |

Setup Items

Setup Description

Caoil

Read

Set the number of max data for device [coil] which can be read for one
communication, using 16 to 2000 bits.

« When [Single Bit manipulation to Coil/Discrete Input] is checked, set the
data maximum number from 1 to 2000.

Coil

Write

Set the number of max data for device [coil] which can be written for one
communication, using 1 to 800 bits.

Discrete Input

Set the number of max data for device [discrete input] which can be read for
one communication, using 16 to 2000 bits.

Read
* When [Single Bit manipulation to Coil/Discrete Input] is checked, set the
data maximum number from 1 to 2000.
Input Register Set the number of max data for device [input register] which can be read for
| Read one communication, using 1 to 125 words.
Holding Register Set the number of max data for device [holding register] which can be read
| Read for one communication, using 1 to 125 words.
Holding Register Set the number of max data for device [holding register] which can be written
for one communication, using 1 to 100 words.

| Write

Single Bit manipulation to Coil/

Discrete Input

Put a check when writing in or reading out coil or discreet input in bits.
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4.2 Setup Items in Offline Mode

NOTE | * Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode or

Cf.

about the operation.

Maintenance/Troubleshooting Guide "Offline Mode"

« The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

4 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

| Cormm, Device Option

MODBUS S10 Master [GoM1] Page 1/1

510 Type k52320 > |

Speed 19200 i

Data Length T e §

Parity NONE e EVEN 0pD

Stop Bit | 2

Flow Control [NONE ==

Timeout(s) 3w | a

Retry 7w | a

Wait To Send(ms) T w | a

: 2005/09/02
Exit Back 1371146

Setup ltems Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT
To make the communication settings correctly, confirm the serial interface specifications of
SIO Type Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display
unit.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.

Select the communication control method to prevent overflow of transmission and
Flow Control

reception data.
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Setup ltems Setup Description
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
In case of no response from the External Device, use an integer from 0 to 255 to enter how
Retry . - .
many times the Display retransmits the command.
Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.

@ Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Device].

Cormm,

Device

Option

MODBUS SI0 Master

Device/PLC MName

Slave fddress

Bit manipulation to HR
[ECET131 Syntax

Double Word word order
Low Security Level

Max Query

Read Coil

Write Coil

Read Discrete Input
Read Input Register
Read Holding Register
Write Holding Register
Single Bit manipulation

Exit

[GOM1] Page 1/1

[PLCT >
1w & |
Rest of bits in word are not cleared
OFF
Low word first
OFF

2000 bits

800 bits

2000 bits
125 =
125 =

JULERN. 4

»(rir

OFF

Back

2007/06/28
12:26:16

Setup Items

Setup Description

Device/PLC Name

Select the External Device for device setting. Device name is a title of
External Device set with GP-Pro EX. (Initial value [PLC1])

Slave Address

Use an integer from 1 to 247 to enter the slave equipment address of the
External Device.

Bit manipulation to HR

From "Rest of bits in word are cleared" or "Rest of bits in word are not
cleared", select treatment of the rest of the bits in the same word when the bit
manipulation to Holding Register is performed. (Not available to set in
offline mode.)

IEC61131 Syntax

Displays the usage status of the currently set IEC61131 syntax in ON/OFF.
(Not available in offline mode.)

Double Word word order

Displays the currently set order of storing double word data from "Low word
first" or "High word first". (Not available to set in offline mode.)

Low Security Level

When an format check level is lowered, ON/OFF is displayed. When the
level is lowered, ON is displayed. (Not available to set in offline mode.)
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Setup Items Setup Description
Coil Displays the number of max data for device [coil] which can be read for one
| Read communication. (Not available to set in offline mode.)
Coil Displays the number of max data for device [coil] which can be written for
one communication. (Not available to set in offline mode.)

| Write

Discrete Input

Displays the number of max data for device [discrete input] which can be
read for one communication. (Not available to set in offline mode.)

| Read
Input Register Set the number of max data for device [input register] which can be read for
| Read one communication, using 1 to 125 words.
Holding Register Set the number of max data for device [holding register] which can be read
| Read for one communication, using 1 to 125 words.
Holding Register Set the number of max data for device [holding register] which can be written
for one communication, using 1 to 100 words.

| Write

Single Bit manipulation

ON/OFF display shows whether the coil or discreet input is written or read
out in bits. If ON is displayed, writing or reading can be executed in bits. (Not
available to set in offline mode.)
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MODBUS SIO Master Driver

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Option].

Cormm, Device

Option

MODBUS S10 Master

RI / MGG

e RI

[GoM1] Page 1/1

YOG

In the case of RS232C, vou can select
the 9th pin to RI{Input) or YCG{AY
Power Supplyy. If wou use the Digital’s
k52320 Isolation Unit, please select

it to VGC.
: 2PB5/ R/ 12
B = 13:11:50
Setup ltems Setup Description
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.
NOTE ¢ GP-4100 series, GP-4*01TM, LT-4*01TM and LT-Rear Module do not have the [Option]

setting in the offline mode.
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Cable Diagram

MODBUS SIO Master Driver

The following cable diagrams may be different from cable diagrams recommended by External Device

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

e The FG pin of the External Device body must be grounded according to your country’s applicable standard.

Refer to your External Device manual for details.

e SG and FG are connected inside the Display. When connecting the External Device to SG, design your system

to avoid short-circuit loops.

¢ Connect an isolation unit if the communication is not stable due to noise or other factors.

51

Cable Diagram 1

Display
(Connection Port)

Cable

Notes

GP3000"1 (COM1)

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+

AGP-3302B (COM2) 1A Terminal Block Conversion Adapter by Pro-face The cable length
GP-4*01TM (COM1) CA3-ADPTRM-01 must be 200m or
ST (COM2) + less.
LT3000 (COM1) User-created cable
1B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
1C Terminal Block Conversion Adapter by Pro-face
* CA3-ADPTRM-01 The cable length
GP3000™ (COM2) + must be 200mgor
User-created cable less.
Online Adapter by Pro-face
CA4-ADPONL-01
1D .
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
IPC*4 1E Terminal Block Conversion Adapter by Pro-face The cable length
CA3-ADPTRM-01 must be 200m or
+ less.
User-created cable
1F User-created cable
The cable length
GP-4106 (COMY) 1G User-created cable must be 200m or
less.
ggiig;&%i’é\ggﬂ 2) The cable length
1H User-created cable must be 200m or

GP-4203T (COML1)

less.
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Display
(Connection Port)

Cable Notes

RS-422 Terminal Block Conversion Adapter by Pro-face

GP4000*6 (COM2) PFXZCBADTM1
*7 The cable length
GP-4201T (COMLI) . + must be 200mgor
SP5000 (COM1/2) User-created cable less.
1B User-created cable
/A
g_éegiagéagl\m) RJ45 RS-485 Cable (5m) by Pro-face The cable length
1] PFXZLMCBRJRS81 must be 200m or

(ComM1) less.

*1  All GP3000 models except AGP-3302B
*2 Al ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
H [PC COM Port (page 7)
*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 1A.
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1A)
e 1:1 Connection
External Device side

Display side Shield Terminal block
Signal name ! ,/ \ Signal name
]
1
- R RDA ] A
Display CA3-ADPCOM-01
RDB B
[ =
= SDA SG
CA3-ADPTRM-01 SDB
TRMRX
SG
FG
User-created cable
e 1:n Connection
) External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name ,'I /' ‘\ Signal name ,/,"",:' ‘\‘ Signal name
/ I ! ! \
RDA f AL A : //\‘\ : A
Display ~ CA3-ADPCOM-01 RDB ' :' ': B :. ‘,‘ B
= SDA i : SG —— SG
F sSDB :: :; _l:_
CA3-ADPTRM-01 | TRMRX i i -
SG : h
FG

A
\ 4

User-created cable

¢ The cable length must be 200m or less.

NOTE I
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1B)

e 1:1 Connection

Display side

MODBUS SIO Master Driver

External Device side

D-sub 9 pin (socket) §t"_e_'9 Terminal block
Pin Signal name ',/ ';7“.‘ Signal name
1 RDA AV A
=| PO
_ ) 2 RDB sndiA B
ey Termination 3 SDA j; :'I l: SG
w7 e Hi A4
S SG =
4 ERA
8 CSA :I
9 ERB :I
6 CSB
Shell FG T “_\,,"
e 1:n Connection
oumBoh el sy TamnAben T gyge | Temben
Pin | Signal name fA Signal name VAN Signal rame
1 RDA AV A / /\, \ A
=| 2 RDB |+ / \ 5 / \ ‘ S
Display Termirﬁon 3 SDA —J:-" :-'I ": sSG ".\ “.\ /." SG
o I I S N I
5 SG 1 : i =
4 ERA
8 Son I
9 ERB
6 CSB ]
Shell FG _'5 ‘\J"

NOTE I

¢ The cable length must be 200m or less.
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1C)

e 1:1 Connection
External Device side

Terminal block Shield Terminal block
Signal name / TAY Signal name
VIR
, CA4-ADPONL-01 RDA T N A
Display : '.'
RDB + T B
l = ! !
1 = SDA ; . SG
1
' ]
CA3-ADPTRM-01 SDB i :
H ]
TRMRX : H
" ]
SG :
1
FG /
User-created cable
e 1:n Connection
) ) External Device side External Device side
Terminal block _Shield Terminal block Shield Terminal block
/ 2y ’ sy
Signal name '/ '," \‘ Signal name ,/ /! \‘ Signal name
! oA / o
Display ~ CA4-ADPONL-O1 RDA T — A //\:'\ : A
RDB [+ : B ‘. B
1 \ 1 1
SDA ; SG ] SG
] \, \ /
CA3-ADPTRM-01 SDB ] I""
TRMRX i ! =
) 1}
SG j
[}
FG /
h User-created cable i
NOTE I ¢ The cable length must be 200m or less.
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1D)

e 1:1 Connection

Display

¢ 1:n Connection

CA4-ADPONL-01

Display [I{p

Shield Terminal block
Pin | Signal name '/', ',I'A\“ Signal name
CA4-ADPONL-01 2 RDA ',"' / I'.' A
7 RDB i ; B
3 SDA ,-: l': SG
8 SDB E o
9 TRMRX VAR
s T | ]
1 | TRMRX Voo
Shell FG | — & I‘\"/
) User-created cable -
External Device side External Device side
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
Pin Signal name ‘," ,/7‘\‘ Signal name ’,’/ /’7\“\‘ Signal name
2 RDA LAY A CA A
7 RDB / \\ B : / \ j B
3 SDA - SG o SG
8 SDB _L ’
1 | TRMRX AN =
5 SG o
9 | TRMRX
Shell G —= ./

D-sub 9 pin (plug)

MODBUS SIO Master Driver

External Device side

\ 4

A

User-created cable

NOTE I

e The cable length must be 200m or less.
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1E)

e 1:1 Connection
External Device side

Display side Shield Terminal block
Signal name ,’l ,r' ‘\ Signal name
CAG
, - RDA T — A
Display CA3-ADPCOM-01 :. / \ '
RDB * I B
= -
// SDA i E i SG
' 1
CA3-ADPTRM-01 SDB i '. .:
] H 1
TRMRX i Vol
\ H h
SG =N
\ [
FG _‘\\ ‘\‘,’l
N User-created cable g
* 1:n Connection
. External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name / I:"\\‘ Signal name '/'““,?\\‘ Signal name
1 [ I ; [}
RDA PN A { //\‘\ : A
H H \ H 1
Display ~ CA3-ADPCOM-01 RDB t : : B = B
| ' \ 1 H
IE SDA P SG i SG
_ SDB : f .E l‘““’
CA3-ADPTRM-01 | TRMRX ". : ,- =
]
] h 'l
e |/ |
FG
User-created cable
NOTE I ¢ The cable length must be 200m or less.
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1F)
+ 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) Shield Terminal block
ST
Pin | Signal name \ Signal name
\
Display % 1 DATA+ : A
1
7 2 | DATA- B
1
Termination 3 NC SG
resistance 7
100Q 1/2W NC
5 GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
Pin Signal name ,:’, /-.‘\ Signal name / / Y Signal name
Display % 1 DATA+ HEAVAR! A ' /\' } A
e o M N
3 Pl R,
Termination NC ! VAR SG \ NS SG
resistance 7 NC H i —
100Q 1/2W : o L
5 GND(SG) . b -
4 ERA I
8 | csa 4_—|
9 ERB oo
6 CcsB :I Voo
Shell FG —‘Q‘ "\/"
NOTE I * The cable length must be 200m or less.
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e 1:1 Connection

Display

MODBUS SIO Master Driver

e 1:n Connection

Display

*1

=|

/

Termination
resistance*1

Display side ) External Device side
Terminal block Shield Terminal block
Signal name ! ! \ Signal name
AL
RDA 4 0 A
= 72N
/ RDB ] § B
]
Pl
Termination SDA :' :' ' SG
resistance*1 SDB E : l:
] ] H
SG : Pt
' ool
ERA ! ool
) 1 H
CSA ] b
\ I
ERB ] oo
\ Y
1
CSB "‘. \ :
' '\‘ H
Display side External Device side External Device side
Terminal block S_tn_e_lgj Terminal block Shield Terminal block
Signal name ':'I ! “‘, Signal name ! /, kY Signal name
RDA / /\\ A /\’\ A
RDB r i B P\ B
SDA ﬂ P SG L SG
SDB oA T
sG — )
ERA ] oo
CSA b
ERB ] Voo
CSB Voo

The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON

NOTE I

¢ The cable length must be 200m or less.
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1H)
e 1:1 Connection
Display side External Device side
D-Sub 9pin (plug) I-S_h_k-al_d_‘ Terminal block
Pin Signal name '," lll “.I Signal name
Display % 3 LINE(+) ,." ', l" A
/ 8 LINE(-) B
Termination 1 NC :: é SG
resistance 2 NG E ':
100Q 1/2W i i
5 GND(SG) ! 5
4 RS(RTS) i
6 5V
7 NC
9 NC
Shell FG —* /
« 1:n Connection
DSbonbg  Sed e g e o
Pin Signal name ,:" ,"“\‘ Signal name / ',’l N Signal name
Display 3 LINE(+) ’,"’ ; ||“. A 'r", /\:' “ A
/% 8 LINE(-) : B / \ ; B
Tomination |1 NC SG o M SG
el 2 T we |1 A4 I
5 GND(SG) : ;
4 RSRTS) | |
6 5V '
7 NC
9 NC
shel | F6 —% 4/

IVIlel=ar\\ill + The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE ¢ In COM on the GP-4107, the SG and FG terminals are isolated.
e The cable length must be 200m or less.
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11y

e 1:1 Connection
External Device side

Display side Shield Terminal block
Signal name ," ,/ \\ Signal name
CAG
) RDA T — A
Display ! / \ \
RDB + P B
| = P
/ SDA E ! : SG
| H H
PFXZCBADTM1 SDB oA
1 H H
TRMRX A
\ \ H
\ \ h
= Y,
\
FG —__\/
User-created cable
« 1:n Connection
. External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name / :’7“‘ Signal name //““'?\\ Signal name
/ \ ! [
RDA f x A L /\‘\ : A
] \ H |
Display RDB ! : |- B :, I'- B
’ ‘ A
% SDA é ] SG Y ___:‘1,/' SG
SDB ' ;
PFXZCBADTM1 | TRMRX : , =
G "
[}
FG f
User-created cable
NOTE I ¢ The cable length must be 200m or less.
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1J)
e 1:1 Connection

External Device side
Terminal block

Disol Signal name
isplay D1
A
DO
B
GND
PFXZLMCBRJR81 SG
e 1:n Connection
E;Q{Qﬁﬂg” External Device side External Device side
100Q 1/2W Terminal block Shield Terminal block
Signal name /’"“,?\\ Signal name
. D1 ] / \ 9
Display g A { /A\ \ A
i ! i
DO ! i !
GND SG “‘ v ’,' SG
PFXZLMCBRJR81 Mmoot
NOTE I ¢ The cable length must be 200m or less.
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5.2 Cable Diagram 2
Di
|splay Cable Notes
(Connection Port)
GP3000 (COML1)
GP4000"! (COM1)
SP5000 (COM1/2) Cable by Schneider Electric Industries
ST (COM1) 2A TSX PCX 1031 (2.5m)"3
LT3000 (COML1) '
IPC™2
PC/AT
User-created cable
+

GP-4105 (COM1) 2B Cable by Schneider Electric Industries

TSX PCX 1031 (2.5m)"?

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
W |[PC COM Port (page 7)

*3  Set the rotary switch to "3 (OTHER DIRECT)".

2A)
External Device
Display
TSXPCX 1031 /O
] =X o / EI
TER port
Mini DIN 8 pin
2B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
ii,—fr?f;l : o Pin iiﬁ?:]ael External Device
Display : P —
RD(RXD) 2 RD(RXD)
SD(TXD) 3 |SD(TXD) TSX PCX 1031 o)
ER(DTR) 4 ER(DTR) |. [S] O /o
SG 5 SG “TER port I:l
RS(RTS) 7 RS(RTS) Mini DIN 8 pin
CS(CTS) 8 CS(CTS)

j;'_

User-created cable

F
v
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Display
(Connection Port)

Cable

Notes

GP3000" (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST"2 (coM2)
LT3000 (COM1)

3A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3B

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.”®

GP3000™ (COM2)

3C

Online Adapter by Pro-face
CA4-ADPONL-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3D

Online Adapter by Pro-face
CA4-ADPONL-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*3

IPC™®

3E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3F

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*3
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MODBUS SIO Master Driver

Display
(Connection Port)

Cable

Notes

GP-4106 (COML1)

3G

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*3

GP-4107 (COM1)
GP-4*03T % (COM2)
GP-4203T (COM1)

3H

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*3

GP4000"7 (COM2)
GP-4201T (COM1)
SP5000 (COM1/2)

3l

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1
*8

+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3B

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*3

LT-4*01TM (COM1)
LT-Rear Module
(coml)

3]

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 5m or less.*3

*1  All GP3000 models except AGP-3302B
*2 Al ST models except AST-3211A and AST-3302B

*3  Max length between the Display and the "Accessory Box connected to Display". Total cable length between
accessory boxes must be 1000m or less (for LT-4*01TM and LT-Rear Module, 195m or less).

*4  All GP3000 models except GP-3200 series and AGP-3302B
*5  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

W |[PC COM Port (page 7)
*6  Except GP-4203T

*7  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*8  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.
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MODBUS SIO Master Driver

3A)
e 1:1 Connection
Terminal block Shield External Device side
ro———- 7,
Signal name '," // \‘\‘ Signal name
VAV
Display CA3-ADPCOM-01 RDA ; / ‘.\ ' Blue | D(B)
)
RDB o+—/ | “——— White| D(A)
| = ! ! :
= SDA - |i E : Red | SG
] ] ! K
CA3-ADPTRM-01 SDB l: ' :: White|  SG
1
TRMRX v/
1 ]
SG L/
\ v !
FG —= A/

\ 4

F 3

User-created cable

¢ 1:n Connection

Terminal block Shield External Device side Shield External Device side
Signal name '/' FAY Signal name J 7N Signal name
h [ 1 ] \
RDA HWAVER! Blue| D(B) |—t —— Blue| D(B)
! \ ! / :,\ \
Display /"> ADPCOM-01 RDB o —— white| D(A) |—t t \“—— white| D(A)
|' H i ] ]
[Ifn IE SDA g : Red | sG '\ '\ ’,’ Red | sG
]
SDB i i Hwnite| sG A\ S—A— White|  SG
| H | Y- b
CA3-ADPTRM-01 TRMRX -: : _T_
1 —
\ H =
SG ';
FG f
h User-created cable .
NOTE I « The cable length must be 10m or less.”?

*1  Max length between the Display and the "Accessory Box connected to Display”. Total cable length
between accessory boxes must be 1000m or less.
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MODBUS SIO Master Driver

3B)
e 1:1 Connection
Display side
D-sub 9 pin (socket) Shield External Device side
re=—-= b2
Pin Signal name ! ;'\‘. Signal name
! P
% 1 RDA ] //\\ L {Bue| D@B)
E 2 RDB o/ N—Jwnite| D(A)
oo
Display  Termination 3 SDA j :' ,: II Red SG
resistance 7 SDB ! ! 1 Whit
100Q 1/2W ; P e] SG
5 SG 0 ' H
' o
4 ERA Pl
[l | H
8 CSA :l Py
\ \ !
9 ERB :I b
1 1
6 CcsB Voo
\ \ 1
Shell FG  |—=
...... 4
b User-created cable "
« 1:n Connection
DispIay side
D-sub 9 pin (socket) Shield External Device side Shield External Device side
[T n 4 N,
Pin Signal name ! A Signal name / PN Signal name
=] RDA //\\ Bue| D(B) [— //\\ i eue] DE)
E 2 RDB v \——white| D(A) | i \——{white| D(A)
Display Termination 3 SDA j:’ :' ': Red SG "‘ ‘,‘ ,,' Red SG
resistance ! : . \ v -
1000 1/2W 7 SDB | i : White| SG - 7 White| SG
5 SG = l """
4 ERA oo =
8 CSA j N
9 ERB :I I
6 CSB Voo
Shell FG  |—= ¥
) User-created cable "
NOTE I « The cable length must be 10m or less.™*

*1  Max length between the Display and the "Accessory Box connected to Display”. Total cable length
between accessory boxes must be 1000m or less.
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MODBUS SIO Master Driver

3C)
e 1:1 Connection
Terminal block Shield External Device side
ym==== A
Signal name / T Signal name
NE
, CA4-ADPONL-01 RDA 4 — Blue | D(B)
Display | / ¥\ \
RDB i i ———Wwhite| D(A)
= P
//':' SDA | o Red | SG
] ] 1
] [ ] .
CA3-ADPTRM-01 SDB : i | White] SG
] ]
TRMRX ! !
' ]
SG : !
1
1
FG /
) User-created cable -
e 1:n Connection
Terminal block Shield External Device side Shield External Device side
Signal name /, ','/ ‘\‘ Signal name // /'7\\ Signal name
Display  CAADPONL-O! RDA f ; +—{ Biue | D(B) [—F / :\ +—{Blue | D(B)
[ﬁ] RDB ,-' i white| D(A) § i \——fwhite| D(A)
SDA 5 Red | sG —+—————Red | sG
CA3-ADPTRM-0T SbB : White|  SG » White|  SG
TRMRX [— _T_
SG ' -
FG
< User-created cable >
NOTE I « The cable length must be 10m or less.*?

*1  Max length between the Display and the "Accessory Box connected to Display”. Total cable length
between accessory boxes must be 1000m or less.
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3D)
e 1:1 Connection
D-sub 9 pin (plug) Shield External Device side
Pin Signal name '/' ',I'A\‘ Signal name
DisplayCA4-ADF>0N|_-01 2 RDA :," /A\i I‘,l Blue | D(B)
7 RDB p i ———White| D(A)
[lﬁ] 3 SDA i teTred| sa
8 SDB white| SG
1 TRMRX
5 SG
o | TRWRX| i
Shell FG — ‘\v,:‘
< User-created cable >
« 1:n Connection
D-sub 9 pin (plug) Shield External Device side Shield External Device side
Pin Signal name ! ! \ Signal name ,// :’/ \‘\‘ Signal name
pispy O 2 RDA //\\ Blue| D(B) :," //\‘\ ".: Blue | D(B)
7 RDB } A White| D(A) ' ' —[White| D(A)
[ﬁ] 3 SDA it TRed| so ——F—Red | SG
8 SDB i : i White|  SG “.‘ “\ ," White|  SG
1 TRMRX _[ /
s | se /| -
o [ TRwrx| 1
Shell FG —‘&\ \‘\, ,r"
< User-created cable >
lﬁ' « The cable length must be 10m or less.”?

*1  Max length between the Display and the "Accessory Box connected to Display”. Total cable length
between accessory boxes must be 1000m or less.
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3E)

e 1:1 Connection
Terminal block Shield External Device side
ro===- ?,
Signal name / / \‘\‘ Signal name
/ /\,’ \
RDA ! — Blue | D(B)
Display CA3-ADPCOM-01 ',' / :\ ':
RDB *- ! 1 White| D(A)
[ = ! o
= SDA 5 o Red | SG
] : [} K
CA3-ADPTRM-01 SDB b 1 {white| SG
\ H 1
TRMRX v/
AR
SG o
1
FG ‘\----.“»"
D User-created cable "
e 1:n Connection
Terminal block Shield External Device side Shield External Device side
Signal name ','I /'-‘\ Signal name ,/'"““/?\ Signal name
RDA ! /\’l -, Bue| D(B) //\."I\ '| Blue | D(B)
Display CSAPPCOM-OT 1 Rpp L/ N white| D(A) =— | \——{wnite| D(A)
SDB ' /oo white|] SG \ \——— White|  SG
CA3-ADPTRM-01 TRMRX -,. :‘. ".' _'L
sa_—+/ 1 i
Fa = \/
< User-created cable >
NOTEI « The cable length must be 10m or less.™?

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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MODBUS SIO Master Driver

3F)
e 1:1 Connection
Display side
D-sub 9 pin (socket) Shield External Device side
’ A
Pin Signal name i A Signal name
.V
Display % 1 DATA+ i / "{'\ ‘.|‘ Blue | D(B)
)
/ 2 DATA- 1 ‘-' 'I White| D(A)
)
! .
Termination 3 NC E :' H Red SG
resistance 7 NC ! q H Whit
100Q 1/2W f i i "] SG
]
5 GND(SG) H i i
| ] 1
4 ERA j b
]
) ]
8 CSA A
\ \ i
1 ]
9 ERB i .
\ 1 ]
6 csB J Vo
\ v
Shell F6 —
| P ¥
User-created cable
e 1:n Connection
Display side
D-sub 9 pin (socket) Shield External Device side Shield External Device side
Pin Signal name ,:" ,:'“‘.‘ Signal name ,’/ ! \\‘ Signal name
Display % 1 DATA+ "v' A! “‘ Blue | D(B) '." //\"’\ “. Blue | D(B)
/ 2 DATA- .' H White| D(A) : i \———white| D(A)
ot 3 NC i ; Red | SG L L' fRed| sG
ermination ! ! \ \ i
w7 T no | A | M se |- fme] s
5| GND(SG) — i )
4 ERA : ' =
8 CsA
9 ERB ; ,:
6 csB
Shell FG ¢ ,"'
) User-created cable -
NQTEI « The cable length must be 10m or less.™

*1  Max length between the Display and the "Accessory Box connected to Display”. Total cable length
between accessory boxes must be 1000m or less.
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MODBUS SIO Master Driver

3G)
e 1:1 Connection
Display side
Terminal block Shield External Device side
Phuceniie =
Signal name ,’I ," \ Signal name
NER
é RDA T / ‘{'\‘ Blue | D(B)
] 1 1
/4_ RDB - I White| D(A)
] i L]
] 1 '|
Display  Termination SDA :' :' ' Red SG
. . ]
resistance*1 SDB ,: :, E White SG
] ] !
SG =
] ] !
ERA :I S
] 1 :
CSA b
] \ !
ERB :l ' :
' ]
CSB R
(R
“ “l"
User-created cable
e 1:n Connection
Display side
Terminal block Shield External Device side Shield External Device side
y===== A ’ N
Signal name ! ;'\I Signal name 7 J Y Signal name
= RDA //\" L {ewe] DE) | //\\ L Tee| D(B)
/ RDB " ; I‘. white| D(A) :' :‘ i white| D(A)
Display Termination SDA j:’ :' ': Red SG I“ ‘.‘ :': Red SG
resistance*1 SDB .: ! E White| SG \ LS + White] SG
SG A
ERA j =
CSA oo
ERB j Voo
CSB Voo

User-created cable

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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MODBUS SIO Master Driver

NOTE I « The cable length must be 10m or less.™*

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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MODBUS SIO Master Driver

3H)
e 1:1 Connection
Display side
D-Sub 9pin (plug) Shield External Device side
Pin Signal name ',’I ;' ‘\ Signal name
N
Display % LINE(+) ‘,/ ‘{'\l'. Blue [ D(B)
1 )
7 8 LINE(-) =/ \——{white| D(A)
1 ] 1
i ] 1
Termination 1 NC :’ :' ! Red SG
resistance ] | .
1000 12w |__2 NC : E' E White|  SG
5 GND(SG) —
H ] ]
4 RS(RTS) ! o
H ] 1
6 5v \ Vo
: ] ]
7 NC \ Vo
\ Vol
9 NC Voo
\ \ S
Shell FG — ‘\”.'
User-created cable
« 1:n Connection
Display side
D-Sub 9pin (plug) Shield External Device side Shield External Device side
Pin Signal name '," ,,T\‘ Signal name /, / ‘\‘ Signal name
AV PN
Display % 3 LINE(+) : /\‘{\ + Blue | D(B) ] / \ i— Blue | D(B)
/ 8 LINE(-) / i White| D(A) f i +— White| D(A)
Termination 1 NC :" i I: Red| SG 1 t ‘;' Red | SG
resistance ! y i . \ \ K X
1000 1/2W 2 NC ! P White[  SG “.____ 7 White| SG
5 |enpse) —— i T
4 RSRTS) | | 1 i =
6 | sv b
7| nc Lo
s [ v |4
Shell G —a A

A

v

User-created cable

IVIlel=ar\\ill « The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

* |n COM on the GP-4107, the SG and FG terminals are isolated.
« The cable length must be 10m or less.”?

*1

Max length between the Display and the "Accessory Box connected to Display”. Total cable length
between accessory boxes must be 1000m or less.
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=

PFXZCBADTM1 TRMRX

3l)
e 1:1 Connection
Terminal block Shield External Device side
rom———— ?,
Signal name ," ,'I “\ Signal name
1
1
RDA - Blue [ D(B)
Display !
RDB >+ White| D(A)
l =l H
= SDA i Red [ SG
1
PFXZCBADTMA1 SDB i White|  SG
1
TRMRX \
1
SG :
FG
b User-created cable g
« 1:n Connection
Terminal block Shield External Device side Shield External Device side
Signal name l,’l ,"”‘\ Signal name /”“““,17\\ Signal name
RDA ! //\\ Blue| D(B) — //\:\ 1 Bue] D)
Display RDB i N —wnie] D) =—/ | \——{wnie| D(A)
= sbA H | ! Red | SG ¥ +—1{ Red| SG
= H ! L \ v
SDB :I Y White] SG Y \\ + White] SG

SG
FG — \
h User-created cable i’
NOTE I « The cable length must be 10m or less.*?

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3J)
e 1:1 Connection
External Device side

Signal name
Display
D1 Biue | D(B)
White| D(A)
Red | SG
PFXZLMCBRJR81
White] SG
« 1:n Connection
I’:Srgtiggggn External Device side Shield External Device side
100Q 1/2W . K N .
Signal name / AR Signal name
Displ D1 ;! [
oy Blue | D(B) |— //\:\ —{ e | D(B)
i i \
White] D(A) 5 i — White| D(A)
1 ]
Red | SG "I +——{ Red| SG
PFXZLMCBRJR81 ) \ v )
White|] SG - S White] SG
NOTE I « The cable length must be 5m or less.*!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 195 or less.
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5.4 Cable Diagram 4
Displ
I pay Cable Notes
(Connection Port)
GP3000 (COM1) User-created cable
GP4000" (COM1) +
SP5000 (COM1/2) RS 232 D tap link cable by Schneider Electric The cable lenath must
ST (COM1) 4A TSX SCP CC 1030 (3m) be 15m or Iesg *3
LT3000 (COML1) + :
IPC*2 PCMCIA card for RS$232C by Schneider Electric
PC/AT TSX SCP 111
User-created cable
+
RS 232 D tap link cable by Schneider Electric
GP-4105 (COM1) 4B TSX SCP CC 1030 (3m) The cable length must
. be 15m or less.
PCMCIA card for RS232C by Schneider Electric
TSX SCP 111
RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21
+
LT-4*01TM (COM1) . . .
LT-Rear Module (COM1) aC RS 232 D tap link cable by Schneider Electric The cable length must

TSX SCP CC 1030 (3m)
+
PCMCIA card for RS232C by Schneider Electric
TSX SCP 111

be 8m or less.

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
H |[PC COM Port (page 7)

*3  Total length for TSX SCP CC 1030 and User-created cable.
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4A)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 25 pin (socket)
Pin | Signal name S /-'A‘\‘ Pin | Signal name
A TSX SCP 111
2 RD(RXD) |e— — TXD
Display 3 SD(TXD) ',: ——» RXD
4 ER(DTR) , i RTS
6 DR(DSR) P E CTS TSX SCP CC 1030
7 | ms@rs) 4 4 20 DTR
8 CS(CTS) ] | E DSR
5 SG i SG
Shell F6 |—3 A
< User-created cable >
lﬁl ¢ The cable length must be 15m or less. 1

*1  Total length for TSX SCP CC 1030 and User-created cable.
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4B)
Display side External D_evice side
Terminal block Shield D-sub 25 pin (socket)
Signal name /I ,"A‘\ Pin Signal name
',' [ TSX SCP 111
RD(RXD) |¢— F— TXD
[}
! HE T
Display SD(TXD) ’, —— RXD
)
ER(DTR) ' o |: RTS
H 1 ]
DR(DSR) ; oo CTS TSX SCP CC 1030
[l ' '
RS(RTS) ] ! b E 20 DTR
H ] ]
CS(CTS) oo 6 DSR
\ Vo
SG I 7 SG
\ [ )
\\ ‘\\ ,,‘
) User-created cable "
NOTE I « The cable length must be 15m or less. !

*1  Total length for TSX SCP CC 1030 and User-created cable.
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4C)

Display

PFXZLMCBRJR21

/

RXD

External Device side
D-sub 25 pin (socket)

Pin Signal name
2 TXD
RXD
RTS
CTS
20 DTR
6 DSR
7 SG

MODBUS SIO Master Driver

TSX SCP 111

TSX SCP CC 1030

NOTE I

« The cable length must be 8m or less. 1

*1  Total length for TSX SCP CC 1030 and User-created cable.
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5.5 Cable Diagram 5

Display

. Cable Notes
(Connection Port)

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+

5A User-created cable
+
*]
GP3000 - (COM1) Uni-Telway cable by Schneider Electric Industries
AGP-3302B (COM2) TSX SCP CU 4030 (3m)
GP-4*01TM (COM1) +
*2
ST # (COM2) PCMCIA card for RS485 by Schneider Electric Industries
LT3000 (COM1) TSX SCP 114
User-created cable
+
Uni-Telway cable by Schneider Electric Industries
5B TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

Online Adapter by Pro-face
CA4-ADPONL-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
5C User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
*3
GP3000 * (COM2) PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

Online Adapter by Pro-face

CA4-ADPONL-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

5D
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MODBUS SIO Master Driver

Display

. Cable Notes
(Connection Port)

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
5E User-created cable
+
Uni-Telway cable by Schneider Electric Industries
IpC™4 TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
5F TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
5G TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

GP-4106 (COM1)

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
5H TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

GP-4107 (COM1)
GP-4*03T" (COM2)
GP-4203T (COM1)

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1
*7

+
User-created cable
51 +
Uni-Telway cable by Schneider Electric Industries
GP4000" (COM2) TSX SCP CU 4030 (3m)
GP-4201T (COM1) +
SP5000 (COM1/2) PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
5B TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114
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MODBUS SIO Master Driver

Display

. Cable Notes
(Connection Port)

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81
LT-4*01TM (COM1) +
LT-Rear Module 5] Uni-Telway cable by Schneider Electric Industries
(Coml) TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
W [PC COM Port (page 7)

*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 5A.

5A)
Terminal block Shield External Device side
Signal name ! P Signal name
NE = TSX SCP 114
Display ~ CA3-ADPCOM-01 RDA 7N ue| D(B) 7
RDB o/ I\——white| D(A) 1
— ! oo
/':' sbA H|i | —4{Red| SG -
VA ) ]
CA3-ADPTRM-01 SDB i : 5 White| SG TSX SCP CU 4030
TRMRX i Voo
\ Voo
se i ]
FG ¢ N/

F 3

v

User-created cable
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5B)
Display side
D-sub 9 pin (socket) Shield External Device side
Pin Signal name ," ,'7\‘\‘ Signal name
% 1 RDA //\\ {——Blue | D(B)
2 RDB i/ N—wnie| D(A)
Termination 3 SDA _J:' P Red SG 1
resistance E i
100Q 1/2W 7 SDB ! i White|] SG 1
Display 5 SG _é— i
4 ERA :'
8 CSA ]
9 ERB ] oo
6 CSB Voo
Shell FG —  \/
\ A"

v

A

User-created cable

TSX SCP 114

TSX SCP CU 4030
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5C)
Terminal block Shield External Device side
ST i -
Signal name ! / \ Signal name TeX SO 114
! P
Display  CA+ADPONLO1 RDA i //\f\ ] Blue | D(B)
' ' K
— RDB } :5 White| D(A)
]
: //':' SDA P Red | SG
] ! )
CA3-ADPTRM-01 SDB ': y White]  SG TSX SCP CU 4030
TRMRX '
1
SG !
FG

v

F 3

User-created cable
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5D)
D-sub 9 pin (plug) Shield External Device side
Pin | Signal name A Signal name
N TSX SCP 114
Display 2 RDA '-'/ '\ T Blue | D(B)
7 RDB T H |'. White| D(A)
p 3 SDA P e Red | sG
CA4-ADPONL-01 8 SDB i : ; White|  SG TSX SCP CU 4030
1| TRMRX i /i
s [ so /1
o |TRMRX| i % {
shel | FG |—&

A
\ 4

User-created cable
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5E)
Terminal block Shield External Device side
Signal name / /’A\‘ Signal name
Y NE TSX SCP 114
Display ~ CA3-ADPCOM-01 RDA i—1 Blue| D(B)
[lj] RDB White| D(A) 1
—
l //:' SDA Red | SG -
CA3-ADPTRM-01 SDB white| SG 1 TSX SCP CU 4030
TRMRX
SG
FG

F 3

v

User-created cable
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5F)

=

Termination
resistance

Display side
D-sub 9 pin (socket)

Pin

Signal name

Shield
-

DATA+

External Device side

DATA-

NC

100Q 1/2W

Display

NC

GND(SG)

ERA

CSA

]

Olo|dh|lO|N|WIN]|—~

ERB

CSB

]

Shell

FG

)

A

Signal name
TSX SCP 114
Blue | D(B) 3
White| D(A) 1
Red SG 1
White] SG 1 TSX SCP CU 4030

User-created cable

A 4
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5G)
Display side
Terminal block Shield External Device side
y===== a
Signal name ! ! \ Signal name
N TSX SCP 114
% RDA ‘.‘ / }‘\ ! Blue | D(B) §
q RDB i/ —whie| D(A) ]
Termination SDA :' :' \ Red SG -
resistance*1 I} | E
SDB b} L White] SG TSX SCP CU 4030
Display SG ; é i
ERA P
CSA :l A
8] Lo
CSB i

F 3

User-created cable

4

*1  Theresistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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5H)
Display side
D-sub 9 pin (plug) Shield External Device side
I I'\\ R
Pin Signal name H Y Signal name
% 3 LINE(+) L AL TBue| D) 1
8 LINE(-) ; ——{white| D(A)
Termination 1 NC :' ' Red SG 1
resistance E i
1000 1/2W 2 NC ' i White| SG 1
Display 5 GND(SG) |— i
4 RS(RTS) | !
: :
6 5V ‘. i
)
7 NC ' i
9 NC ;
Shell FG [ !

\4

A

User-created cable

MODBUS SIO Master Driver

TSX SCP 114

TSX SCP CU 4030

IVIlel=ar\\ill + The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS

connector. Do not use it for other devices.

NOTE I

* |n COM on the GP-4107, the SG and FG terminals are isolated.
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51)
Display
l —
, =3
/
PFXZCBADTM1

Terminal block Shield External Device side
Signal name ’/I '/,.\‘ Signal name
RDA "' /\"‘ ‘II'. Blue| D(B) Y
RDB / \ —{white| D(A) 1
SDA i | —etRrRed| sG
SDB LY Hwee| sa
TRMRX | | f
SG ‘I'.
FG IRV

v

F 3

User-created cable

TSX SCP 114

TSX SCP CU 4030

GP-Pro EX Device/PLC Connection Manual 94



MODBUS SIO Master Driver

5J)
External Device side
) Signal name
Display D1 TSX SCP 114
Blue| D(B) 3
Do White| D(A) 1
GND Red SG
PFXZLMCBRJR81
White] SG 1 TSX SCP CU 4030
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5.6 Cable Diagram 6
Displa
I p / Cable Notes
(Connection Port)
GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COM1) 6A User-created cable Igr?]c;bllgslsength must be
LT3000 (COML1) '
IPC™?
PC/AT
GP-4105 (COML) 6B User-created cable The cable length must be
15m or less.
LT-4*01TM (COM1) RJ45 RS-232C Cable (5m) by Pro-face
LT-Rear Module (COM1) 6C PFXZLMCBRIR2L The cable length must be
5m or less.
*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.
W |[PC COM Port (page 7)
6A)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
Pin Signal name I/ ! \‘\‘ Pin Signal name
| R
2 RD(RXD) ; ><f 4 2 RXD
] 1 l'
3 |sD(TXD) LN 3 TXD
Display ! oo
4 ER(DTR) | L — 5 SG
] ] !
6 |bRosm)| i i I: 6 DSR
7 [mrsmTS)| t b 7 RTS
Voo
8 |cs(cTs) <_—| Voo I: 8 CTS
Shell FG [—& 3/
User-created cable
NOTE I ¢ The cable length must be 15m or less.
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6B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal name l,’l / ‘\‘ Pin Signal name
RD(RXD) / ><" 4 2 RXD
SD(TXD) N 3 TXD
Display ERDTR) E ' 5 G
SG —l—// 4 DTR
DR(DSR) P I: 6 DSR
RS(RTS) b 7 RTS
CcS(CTS) :l oo I: 8 CTS
User-created cable
NOTE ¢ The cable length must be 15m or less.
6C)
External Device side
D-sub 9 pin (plug)
Display O Pin Signal name
2 RXD
RXD
3 TXD
GND

PFXZLMCBRJR21 5 SG

I: 4 DTR

6 DSR

7 RTS

I: 8 CTS

NOTE I ¢ The cable length must be 5m or less.
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5.7 Cable Diagram 7
Displa
p_ y Cable Notes
(Connection Port)
GP3000 (COM1)
GP4000™! (COM1) D-Shell adapter by Schneider Electric The cable
SP5000 (COM1/2) 110 XCA 203 00 lenath must
ST (COM1) 7A + boomT o
LT3000 (COM1) RS232 communication cable RJ45 to RJ45 by Schneider Electric Iess.
IPC*2 110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m) '
PC/AT
User-created cable
+
D-Shell adapter by Schneider Electric ;I::]e tChalr)TIlist
GP-4105 (COM1) 7B 110 XCA 203 00 g
+ be 9.5m or
RS232 communication cable RJ45 to RJ45 by Schneider Electric less.
110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)
*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.
H [PC COM Port (page 7)
TA)
110 XCA 282 01
110 XCCX 282 02 Extermal Device
Display or
110 XCA 282 03
[] ': I, {1
[
110 XCA 203 00 AN
Modbus port 1
NOTE I ¢ The cable length must be 9.5m or less.
7B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal ! B Pin Signal 110 XCA 282 01
Display name : H name or i
RD(RXD) : : 2 |RD(RXD) 110 XCA 282 02 Extermal Device
SD(TXD) 3 | SD(TXD) 110 xc?Arzsz 03 -
D—
ER(DTR) 4 [eroR)| [ = 0 m
SG 5 SG__ |110xcA 20300
RS(RTS) 7 RS(RTS) Modbus port 1
CS(CTS) o 8 |CS(CTS)
L
) User-created cable "
NOTE I ¢ The cable length must be 9.5m or less.
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5.8 Cable Diagram 8

Display
(Connection Port)

Cable Notes

COM Port Conversion Adapter by Pro-face

GP3000"! (COM1) CA3-ADPCOM-01
AGP-3302B (COM2) +
GP-4*01TM (COM1) | 8A Terminal Block Conversion Adapter by Pro-face The cable length
ST < (COM2) CA3-ADPTRM-01 must be 500m or less
LT3000 (COML1) + '
IpC™3 User-created cable

8B User-created cable

Online Adapter by Pro-face
CA4-ADPONL-01

+
8C Terminal Block Conversion Adapter by Pro-face
. CA3-ADPTRM-01
GP3000™ (COM2) + The cable length
User-created cable must be 500m or less.

Online Adapter by Pro-face
CA4-ADPONL-01

8D +
User-created cable
GP-4106 (COM1) 8E User-created cable The cable length
must be 500m or less.
RS-422 Terminal Block Conversion Adapter by Pro-face
GP4000"5 (COM2) PFXZC??DTMl
GP-4201T (COM1) 8F The cable length
SP5000 (COM1/2) User cre;ted cable must be 500m or less.
8B User-created cable

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B

*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
W [PC COM Port (page 7)

*4  All GP3000 models except GP-3200 series and AGP-3302B
*5  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*6  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 8A.
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8A)
External Device Modbus port 2
Terminal block Shield D-sub 9 pin (plug)
Signal name ,/’ / \ Pin Signal name
b ALY
Display CA3-ADPCOM-0f RDA 1« / “{\ A 1 TXD+
[Ij] — RDB (e i\ 6 TXD-
[ = SDA //\: < RXD+
CAB3-ADPTRM-01 SDB i > 7 RXD-
TRMRX (— & L — 3 SG
sG —/ .-'
FG _‘*‘ ‘\\vll'
h User-created cable "
NOTE I ¢ The cable length must be 500m or less.
8B)
Display side External Device Modbus port 2
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
Pin Signal name :’I ,l' ‘\ Pin Signal name
% 1 ROA  fe—i—AN 1 TXD+
E 2 RDB [« [M— 6 TXD-
PN L
Display Termination 3 SDA E / :\ 2 RXD+
resistance H
100Q 1/2W 7 SDB E > 7 RXD-
5 SG E 3 SG
4 ERA
8 CSA :I b
9 ERB :I Voo
6 CSB Voo
Shell FG —'q‘ ".‘ /
NOTE I ¢ The cable length must be 500m or less.
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8C)
External Device Modbus port 2
Terminal block Shield D-sub 9 pin (plug)
y===== )
Signal name / A Pin | Signal name
/ /\:’ \
RDA [ — 1 TXD+
Display CA4-ADPONL-01 : / N \
RDB [« ': f 3 6 TXD-
= '
CA3-ADPTRM-01 SDB P 7 RXD-
TRMRX —_/— 3 SG
SG T Vo
FG 4\
| Y. kY
) User-created cable "
NOTE I ¢ The cable length must be 500m or less.
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8D)
External Device Modbus port 2
D-sub 9 pin (plug) Shield D-sub 9 pin (plug)
Pin  |Signal name :,,:"-""17\““ Pin | Signal name
iopiay CA4ADPONLO1 2 RDA |« :.'I //\:1:\ ".| 1 TXD+
7 RDB (e i\ 6 TXD-
3 SDA LN > 2 RXD+
8 SDB / i\ > 7 RXD-
1 TRMRX | 3 SG
5 | s6 —"t
o |TRMRX | } | !
Shell FG _“\_---.\5, ,'"
< User-created cable >
lﬁl « The cable length must be 500m or less.
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8E)
Display side External Device Modbus port 2
Terminal block Shield D-sub 9 pin (plug)
Signal name ,,'I ,r'“\‘ Pin Signal name
% RoA AL 1 TXD+
E RDB [/ N 6 TXD-
Display Termination SDA / \ > 2 RXD+
resistance*1 SDB > 7 RXD-
SG 3 SG
ERA
CSA :I } !
ERB :I oo
CSB
NOTE I ¢ The cable length must be 500m or less.
*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
8F)
External Device Modbus port 2
Terminal block Shield D-sub 9 pin (plug)
Signal name 3 TA Pin Signal name
N
RDA [——/\— 1 TXD+
Display h / }\ i
RDB - [ 6 TXD-
1 = H A ]
// — SDA i / —> 2 RXD+
! AN
PFXZCBADTM!1 SDB ' b 7 RXD-
' 1
TRMRX ;f_ 3 SG
SG =
\ \‘ I'
FG [\
) User-created cable -
NOTE I ¢ The cable length must be 500m or less.
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5.9 Cable Diagram 9
Displ
ISp. =/ Cable Notes
(Connection Port)
GP3000 (COM1)
GP4000™! (COM1)
SP5000 (COM1/2)
ST (COM1) 9A User-created cable Ig;cc?fll;l:ngth must be
LT3000 (COM1) '
IPC™?
PC/AT
GP-4105 (COMLY) 9B User-created cable The cable length must be
15m or less.
*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.
W |[PC COM Port (page 7)
9A)
Display side ) External Device side
D-sub 9 pin (socket) EPE'_d’ D-sub 9 pin (socket)
Pin Signal name '/I ',’I ‘\ Pin Signal name
' [
2 RD(RXD)[¢— T v 3 SD
] ] \
3 SD(TXD) i e RD
Display H i
4 ER(DTR) : I P 6 DR
1 H !
5 SG At 5 SG
\ 1 !
7 |RSRTS)IH + b i I__, 7 RS
\ \ i
8 CS(CTS) :I \ \ ! 8 (O]
\ vy
Shell FG |—»----- v
NOTE I ¢ The cable length must be 15m or less.
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9B)
Display side ) External Device side
Terminal block f*jflfi’ D-sub 9 pin (socket)
Signal name I," ,,’I \ Pin Signal name
RD(RXD) {—F—— 3 SD
SD(TXD) A —— RD
Display !
ER(DTR) > 6 DR
SG v ' 5 SG
RS(RTS) b I__, 7 RS
CS(CTS) :I Voo 8 cs
NOTE I e The cable length must be 15m or less.
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5.10 Cable Diagram 10

MODBUS SIO Master Driver

Display
(Connection Port)

Cable

Notes

GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COM1)
LT3000 (COM1)
IPC™2

PC/AT

10A

User-created cable

The cable length must be
15m or less.

GP-4105 (COM1)

10B

User-created cable

The cable length must be
15m or less.

*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.

W |[PC COM Port (page 7)

10A)

Display

Display side External Device side
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)

Pin Signal name '/’, ',’7“\ Pin Signal name

2 |RoRxXD)le—— 3 SD

3 |[spxp) I NN RD

4  |ER(DTR)—i e » 6 DR

5 SG — 5 SG

7 |rRsmTgl L 1 7 RS

8 |cs(CTs) :I I: 8 cs
Shell F6 vy L[ CD

NOTE I

e The cable length must be 15m or less.
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|

10B)
Display side External Device side
Terminal block _S_h_nfl_d D-sub 9 pin (plug)
Signal name '/I ,,’I ‘\ Pin Signal name
RD(RXD) _je—F—F— 3 sD
SD(TXD) A S SN R RD
Display '
ER(DTR) B 6 DR
SG v H 5 SG
RS(RTS) 7 RS
CS(CTS) :I Voo I: 8 cs
— j_ > CcD
NOTE I e The cable length must be 15m or less.
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Display
(Connection Port)

Cable

Notes

GP3000"1 (COM1)
AGP-3302B (COM?2)

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+

GP-4*01TM (COM1) | 11A Terminal Block Conversion Adapter by Pro-face The cable length
ST™? (ComM2) CA3-ADPTRM-01 must be 1000m or
LT3000 (COM1) + less.
IPC? User-created cable
11B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
11C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
GP3000™ (COM2) + ;hetczb'io'gg?nth r
User-created cable Ie:ss ¢ 0
Online Adapter by Pro-face
11D CA4-AD+PONL-01
User-created cable
The cable length
GP-4106 (COM1) 11E User-created cable must be 1000m or
less.
RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) 11F The Czb'i length
SP5000 (COM1/2) + must be 1000m or
User-created cable less.
11B User-created cable

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

B [PC COM Port (page 7)

*4  All GP3000 models except GP-3200 series and AGP-3302B
*5  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*6  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 11A.
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11A)
e 1:1 Connection
Display side External Device side

Terminal block RS-422/485
Communication

Signal name Shield Terminal block
Termination 2 A
resistance | TERM ’,’l '," \ Signal name
1200 1/2W ! [
Display CASADPCOM-01 g RDA ! / '}\ ! Tt
'spay RDB < l.' Tx- Termination
)

= /\E resistance
q = SDA X »  RX+ §091/2W
1
1
1
CA3-ADPTRM-01 SDB \ Vo RX-
1
SG ——f SG
\ vy
FG A N Y
N User-created cable "
« 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
Communication Communication
Signal name Shield Terminal block Shield Terminal block
roomaneel TERM FEE A Signal name A Signal name
1200 1/2W VY .VIR! NI
. CA3-ADPCOM-01 g RDA ] / }\ ' Tx+ i / }\ ] Tx+
Display RDB < ! Tx- ! Tx- Termination
= /\; /\; resistance
= SDA % >  RX+ / \ RX+  [120012W
] ]
CA3-ADPTRM-01 SbB ' ".‘ I RX- \ "-‘ ! RX-
SG ¥ T i SG ¥ T i SG
\ A \ Ay
FG I S V) R ‘j'_
h User-created cable g
NOTE I ¢ The cable length must be 1000m or less.
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11B)
e 1:1 Connection
External Device side
) . RS-422/485
Display side Communication
D-sub 9 pin (socket) Shield Terminal block
Esrirgtlgﬁggn Pin  [Signal name ! A Signal name|
120Q 1/2W ! i
5 1 RDA  f+— /\,'\ '-. Tx+
2 RDB 4—1J i\ Tx- | Termination
i o resistance
3 SDA EN LT Ry 1200 12w
Display / %
7 SDB P RX-
5 SG SG
4 ERA
8 CSA :| [
9 ERB :| oo
6 CSB Voo
Shell G —a 4/
e 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Display side Communication Communication
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
fermination) - pin | Signal name ‘/' ’,'l ‘\‘ Signal name '," ’.’I “\‘ Signal name
1200 ”2% 1 ROA  —i—A\ Tx+ : /\'\ - Tx+
1 H H 1
2 | RoB p— ] Tx 5 Tx |l
3 SDA A S SN =SV RX+ 1200 12w
Display / \ ! / ‘.\ i %
7 SDB > RX- r \ ,-' RX-
5 SG SG s SG
4 ERA _L
8 CSA :| : v
' [
9 ERB :| | Vo
' Vo
6 CSB Voo
shell | FG  |—a i/

¢ The cable length must be 1000m or less.

NOTE I
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11C)

e 1:1 Connection

Display s

ide

Terminal block

MODBUS SIO Master Driver

External Device si
RS-422/485

¢ 1:n Connection

Display

de

) . Communication
Signal name I_S_fll_ejg\ Terminal block
Termination| / N\ K
resistance | TERM / / \ Signal name|
1209 1/2W P [
. CA4-ADPONL-01 RDA [« \ Tx+
Display ! ' \ -
RDB < H Tx- Ter_mmatlon
/\: resistance
= SDA >  RX+ |[120012W
)
L/—‘ RN E
H -
CA3-ADPTRM-01 SDB \ v RX
1
SG ——f SG
FG oo
< >
User-created cable
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
,Teiﬁ’;”tg‘,?c“;’r TERM i FAY Signal name i FAY Signal name
1200 1/2W PR,V JEAVER
CA4-ADPONL-01 g RDA ! / }\ 4 Txt i / }\ i Tt
RDB < H Tx- H Tx- Termination
H H resistance
[Iﬁ = SDA A > RX+ A > RX+ [120012W
CA3-ADPTRM-01 Sbe \ ".‘ ! RX- | "-‘ ! RX-
! H
SG T T H SG T T H SG
\ L \ [
FG Y \ N

A

User-created cable

\4

NOTE I

¢ The cable length must be 1000m or less.
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11D)
e 1:1 Connection

External Device side

) _ RS-422/485
Display side Communication
D-sub 9 pin (plug) Shield Terminal block
:’eeszrggr?ctign Pin  |Signal name| ,,'l ',” ‘\‘ Signal name
1 1 I}
1200 1/2% > RDA [+ //\‘,\ : Tx+
Display 7 RDB [« ! ," Tx- Termination
H resistance
3 SDA N »  RBXs |120012wW
8 soB —+ i Rx
CA4-ADPONL-01 5 sSG | -, SG
Shell FG [—%--¥
N User-created cable e
* 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Dlsplgy side Communication Communication
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
;r;fsﬁgg‘ﬁéign Pin Signal name / ',” \ Signal name / ',” N\ Signal name
12091/2% 2 RDA |+ :.' //\’.'\ “. Tx+ :.’ / ‘.'\ “. Txs
Display 7 RDB [+ / ," h Tx- ! ," h Tx- Termination
/\: /\!: resistance
3 SDA >  RX+ 7N RX+ é‘m vaw
8 sbB —+ i~ Rx = RX-
CA4-ADPONL-01 5 SG i L SG | L SG
shell | FG — oV e j_
N User-created cable "
NOTE I ¢ The cable length must be 1000m or less.

GP-Pro EX Device/PLC Connection Manual 112



MODBUS SIO Master Driver

11E)
* 1:1 Connection
External Device side
_ . RS-422/485
Display side Communication
Terminal block Shield Terminal block
Termination | Signal name AN Signal name|
resistance*1 ! [
g RDA *~—— A T Tx+
! 1 [} . )
RDB [+~ /\.-' LS Pl
»  RX+ [120012W
Display SDA / \
SDB > RX-
SG SG
ERA :|
CSA | [
[ I
ERB :| i .
CcSB oot
IRV
* 1:n Connection
External Device side External Device side
RS-422/485 RS-422/485
Display side Communication Communication
Terminal block Shield Terminal block Shield Terminal block
Termination Signal name / /\';' ‘\‘ Signal name / /\,r"’ \“ Signal name
resistance*1 RDA < " L I'. Tx+ " / :\ 1“ Tx+
g RDB «— i\ Tx- { Tx- Termination
|: /\' H A resistance
_ SDA »  RX+ A RX4  |1200 12w
Display / \ | / g\ ; %
SDB > RX- T VT RX-
SG SG SG
ERA :| _I__
CSA Vol
ERB :| oo
H o
CSB Voo
*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the

rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON

NOTE I

e The cable length must be 1000m or less.
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11F)
* 1:1 Connection
Display side External Device side
Terminal block RS-422/485
- Communication
Signal name Shield Terminal block
Terminati / ™,
r:srirgtlgra\égn TERM / / ‘\ Signal name
1 1 1
120Q 1/2W H HERY
5 RDA [+ /\\ i Tx+
Display RDB — ," H Tx- Termination
= /\j resistance
= SDA A > RX+ é‘m 2w
[}
1
1
PFXZCBADTM1 SDB '.‘ ". ! RX-
1
SG —— SG
\ L)
FG |—e----¥
h User-created cable "
* 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
X Communication Communication
Signal name Shield Terminal block Shield Terminal block
P / AN / A
,T;’;{Q{Qﬁggn TERM / / \ Signal name / / \ Signal name
12"“”2% RDA ¢t /\\ : Tx+ ! //\,\ ; Tx+
Display RDB | H A Tx- ! A Tx- Termination
— /\j /\j resistance
[| = SDA > RX+ / \ RX+  |120Q12wW
/ i\ \
PFXZCBADTM1 SbB ". I RX- '.I Vo RX-
\ I ' )
SG T " i SG T " i SG
FG |—%---¥ S

\4

User-created cable

NOTE I ¢ The cable length must be 1000m or less.
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5.12 Cable Diagram 12
Displa
p. 4 Cable Notes
(Connection Port)
COM Port Conversion Adapter by Pro-face
q CA3-ADPCOM-01
GP3000 - (COML1) +
AGP-3302B (COM2) 12A Terminal Block Conversion Adapter by Pro-face The cable
GP-4*01TM (COM].) CA3-ADPTRM-01 Iength must be
ST (COM2) + 1000m or less.
LT3000 (COM1) User-created cable
12B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
12C Terminal Block Conversion Adapter by Pro-face
. CA3-ADPTRM-01
GP3000"2 (COM2) . The cable
length must be
User-created cable 1000m or less.
Online Adapter by Pro-face
12D CA4-AD+PON L-01
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
IPC*4 12E Terminal Block Conversion Adapter by Pro-face The cable
CA3-ADPTRM-01 length must be
+ 1000m or less.
User-created cable
12F User-created cable
The cable
GP-4106 (COM1) 12G User-created cable length must be
1000m or less.
GP-4107 (COML1)
* The cable
GP-4*03T" (COM2)
GP-4203T (COM1) 12H User-created cable length must be
1000m or less.
RS-422 Terminal Block Conversion Adapter by Pro-face
GP4000*® (COM2) PFXZCBADTM1
121 *7 The cable
GP-4201T (COM1) lenath must be
SP5000 (COM1/2) + e
User-created cable 1000m or less.
12B User-created cable
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face The cable
LT-Rear Module (COM1) 12J PFXZLMCBRJR81 length must be
200m or less.

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
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Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
W |[PC COM Port (page 7)

Except GP-4203T

All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 12A.

12A)

¢ 1:1 Connection

Display side
Terminal block

External Device side

RS-422/485

- . Communication
Signal name ,Shlelq\ Terminal block
Terminati J A :
roammeronl TERM / A Signal name
1200 1/2W ! [
, CA3-ADPCOM-01 g RDA / P T+
Display RDB e |! ! ! Tx- Termination
H /\j ! resistance
|E I\ G 120Q 1/2W
H 1
CA3-ADPTRM-01 SDB \ ".| ! RX-
1
SG T T # SG
v v
FG  —V
- User-created cable "
e 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
) ) Communication . Communication
Signal name ,Shlelq‘ Terminal block ,Shlelci‘ Terminal block
L‘Z@,g‘ﬁé’:n TERM ,,’I ,,’I \ Signal name ,,’I ,,’I \ Signal name
1200 1/2W ! [ ! P
! CA3-ADPCOM-01 RDA i i “'. Txt i i “'. Tx
Display RDB e |! ! ] Tx- ! H ! Tx- Termination
[Iﬁ /\: ! /\j ! resistance
IE . —>  RX+ ; RX+  [12001/2W
- - /N / N\ E
1 ! 1 !
CA3-ADPTRM-01 SbB \ Vo RX- \ Vo RX-
1 1
sG — sG e 86
\ \ ,’l \ \ ,’l
FG —% -2 Y e j_

\4

A

User-created cable

¢ The cable length must be 1000m or less.

NOTE I
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12B)
e 1:1 Connection

External Device side

Display side RS-422/485
play i Communication
D-sub 9 pin (socket) Shield Terminal block
rostianes”|  Pin  [Signal name| ! ,," \\‘ Signal name|
120Q 1/2W i
5 1 RDA P Tx+
! | \ o
2 | ROB Je| i i | T | Termnaten
i 1 |
3 SDA L A o Rx+ [1200172wW
Display /
7 SDB > RX-
5 SG SG
4 ERA
8 CSA :| i :
] 1
9 ERB :I T
] i H
6 CSB Voot
\ (]
Shell FG  |—a 1/
e 1:n Connection
External Device side External Device side
Displ d RS-422/485 RS-422/485
Isplay side ) Communication ) Communication
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
fermination  pin  [Signal name ::’ ’," “.‘ Signal name '/' ’," “.‘ Signal name
1200 1’2% 1 RDA P T+ P Tx+
H I 1l H Il ' -
2 RDB fe | i | % Tx- N T | fooetance”
H i il H | '
3 SDA LA > RX+ A RX+  [120012wW
Display / '.‘ / \I\ !
7 SDB »  RX N RX-
5 SG SG A SG
4 ERA _L
8 CSA :| P )
9 ERB :| oo
' Vo
6 CsB Voo
shel | FG |—a i/
NOTE I ¢ The cable length must be 1000m or less.
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12C)
e 1:1 Connection

Display side
Terminal block

MODBUS SIO Master Driver

External Device side
RS-422/485

) Communication
Signal name Shield Terminal block
Termination / AN "
e e A
1 ] H
. CA4-ADPONL-01 g RDA [ T
Display RDB e |! ! | Tx- Termination
H H ! resistance
= SDA PN LT Rx; 2001w
! / N %
: A\t
CA3-ADPTRM-01 SDB ] '-‘ 7 RX-
1
SG T T i SG
FG eV
N User-created cable e
e 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
A / ™ / ™
L‘Z’{;}Lj‘ﬁéﬁ” TERM ,,’ ’,” \‘ Signal name ,,’ ’,” \‘ Signal name
1200 1/2W H P ] [
' CA4-ADPONL-01 g RDA ! P Tx+ ! P T+
Display RDB e ! i Tx- H ! Tx- Termination
H H H H resistance
% SDA A —> RX+ A U RX+ 1200 1/2W
ANE AN
1 1 1 1
CA3-ADPTRM-01 SDB \ ".‘ ! RX- \ "‘ ! RX-
1 1
SG T —t SG T —t SG
FG —b-“ “v’/ \ \jl_/

\4

A

User-created cable

NOTE I

¢ The cable length must be 1000m or less.
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12D)
e 1:1 Connection

External Device side

RS-422/485
Display side Communication
D-sub 9 pin (plug) Shield Terminal block
Termination)  pin  |Signal name| ,," '," '\‘ Signal name
1 1 I}
1200 1/2% B RDA i i | Txt
Displa: i} o ) Terminati
play 7 | RoB i i b | Tx |remnan
3 SDA | //\ Lo Rxs  [120212w
N\
[D 8 SDB b \—-—> RX- E
\ \ !
CA4-ADPONL-01 5 sG : > ',‘ sSG
Shell FG |—e----V
< User-created cable >
e 1:n Connection
External Device side External Device side
RS-422/485 RS-422/485
Display side Communication Communication
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
Termination  pin  [signal name ,," '," \\‘ Signal name ,," '," \\‘ Signal name
1200 ”2% 2 RDA P T+ P Tx+
Display 7 RDB | ," ," I: Tx- ," ," I: Tx- Termination
! /\j ! H /\: ! resistance
3 SDA : / - RX+ : / \ : RX+  |120012W
i N \ N\
8 SDB i RX- i RX-
CA4-ADPONL-01 5 SG ‘-“ ! ".‘ SG ‘-“ ! ".‘ sSG
Shell FG |—---V A S— j_
- User-created cable i’
NOTE I ¢ The cable length must be 1000m or less.
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12E)
e 1:1 Connection
Display side External Device side
Terminal block RS-422/485
- Communication
Signal name Shield Terminal block
. . 4 o, . .
Termination  TERM '," ',” ‘\“ Signal name | Termination
1200 1/2W it ANy 1200 1/2W
Display CASADPCOM-01 g RDA VA N RX+ %
ik RDB i RX-
— H HE
= SDA [ Tx+
\ .
1 1 1
CA3-ADPTRM-01 SbB ".‘ “. : Tx-
1
SG T T i SG
FG |—y
h User-created cable "
e 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
- K A K A _—
L‘Zﬂgg‘ﬁéﬁr TERM / ’,”\‘ Signal name / ’,”\‘ Signal name ;I;}eér;}g:égn
! ! ! !
1200 2WT e e AL L T Ry A RXs 1200 1/2W
Display CA3-ADPCOM-01 g T/ .‘\ i i / \ \
| AN | AN
— RDB 7 : : RX- 7 : : RX-
= SDA P T P Tx+
' H ' ] [} I
\ [ \ [
CA3-ADPTRM-01 SDB ".‘ ".‘ : Tx ".‘ ".‘ : Tx
! !
SG ‘-\ 7 SG ‘-\ 7 SG
FG  —V L j_

User-created cable

NOTE I ¢ The cable length must be 1000m or less.
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e 1:1 Connection

MODBUS SIO Master Driver

External Device side

Display side Communication
D-sub 9 pin (socket) Shield Terminal block
%é%;‘i}i%: Pin Signal name I‘/ ,"‘“‘"‘ Signal name 'rf;esrirgtigra]ggn
5 1 DATA+ |e— Ad——  Rx+ ém”zw
2 DATA- 4—;/ \—.—> RX-
3 NC A Tx+
Display i b
7 NC ! o Tx-
5 | GND(SG) —_ SG
4 ERA N
oo
8 CSA :| ' Vo
9 ERB :| oo
6 csB Voo
Shell FG  |—a A/
e 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Display side ) Communication ) Communication
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
;Esrgtigr?}:ign Pin Signal name '," :,‘“\“ Signal name '," ",’l “\“ Signal name rTgsrgtigg‘cig"
R DATA+ fe—Ad——{  Rx f /\\ t Rx+  [12001/2W
1 H l’ |‘
3 2 DATA- 4_‘/ \——> RX- = N RX-
oo R
ey 3 NC Tx+ oo Tx+
7 NC ' P Tx- [ Tx-
5 GND(SG) — SG SG
4 ERA :| _]:_
8 CSA N
9 ERB :| oo
6 CsB Voo
Shell I Y

NOTE I

¢ The cable length must be 1000m or less.
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12G)
e 1:1 Connection

External Device side
RS-422/485

Display side ) Communication
Terminal block Shield Terminal block
Terminaﬁoq Signal name ’,' i \‘ Signal name
istance* ! i
resis ancig_ RDA -" i ‘.‘ Tx+
B | f x| resstance”
Li L »  RX+ 1200 1/2W
Display SDA I / \
SDB ™ RX
SG SG
ERA :|
CSA vl
| Voo
ERB :| f Vol
\ v
CSB Voo
e 1:n Connection
External Device side External Device side
) . RS-422/485 RS-422/485
DISP!ay side . Communication . Communication
Terminal block Shield Terminal block Shield Terminal block
o Signal name / A Signal name| S /' Signal name|
Termination ! [ ! foA
feS'S‘a”Ce‘g RDA P Tx+ oo Tx+
) [ i ! ' -
RDB  fe|i | i Tx- oo x| rosstance”
SDA LA L Ry A ! AX+ 1202 12w
Display / '-‘/ \.\ !
SDB > RX- T V7 RX-
sG SG SG
ERA :| _I__
CSA ! ]
! Voo
ERB :| i Vo
! Vol
CSB [
\ v

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
lﬁ' ¢ The cable length must be 1000m or less.
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12H)
e 1:1 Connection

External Device side

, ) RS-422/485
Display side Communication
D-sub 9 pin (plug) Shield Terminal block
oo Pin Signal name :‘/ ’,‘l “.‘ Signal name | Termination
1200 1/2W ! {3
g 3 LINE() A T
8 LINE() [+ ‘—~—> RX-
, 1 NC oo Tx+
Display i : i
2 NC ! N Tx-
! | |
5 GND(SG) —t— SG
4 | RS(RTS) oo
6 5V oo
T ] L
9 NC oo
Shell F6 —=  \/
e 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Dlsplay_S|deI . Communication ) Communication
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
Lesrirggﬁésn Pin Signal name ‘," ’," ‘\‘ Signal name ’," ’.’I “.‘ Signal name :;i"irs"‘g‘r?é?"
1200 1/2% 3 LUNEQ) |—i JAN {4 RX+ ,“ //\, ! Rx+  |1202 172w
A N f/ON_d
8 LINE(-) 4—f/ e RX- i RX-
! H \ H 1 1
1 NC i P Tx+ i [ Tx+
Display i ! ! | \ :
2 NC ! HE Tx- \ Vo Tx-
oo Voo
5 GND(SG) B SG P SG
4 RS(RTS) N _l_
' Voo =
6 5V : Vol
[l H H
7 NC Voo
| Vool
s | nc Lo
Shell G —=  \/

IVlel=ar\\ill *+ The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE ¢ In COM on the GP-4107, the SG and FG terminals are isolated.
« The cable length must be 1000m or less.
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121)

1:1 Connection

External Device side

Display side
RS-422/485

Terminal block

. . Communication
Signal name Shield Terminal block
;E;{::gﬁggn TERM ‘," ’,” ‘\‘ Signal name
120Q 1/2W H b
_ g RDA i i |‘.' Tx+
Display RDB e |! ! ! Tx- Termination
: : : resistance
= SDA A R éOQ“ZW
1
PN
PFXZCBADTM1 SDB \ ".‘ ' RX-
1
v
SG T W, SG
FG  ——vV
b User-created cable g
* 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
) . Communication . Communication
Signal name Shield Terminal block Shield Terminal block
_— ’ n , n
:;esri";t'gggg” TERM ','l ’,” \\‘ Signal name ','l ’,” \\‘ Signal name
120Q 172W H [ H i
Display RDB e :- :- i Tx- :' :' | Tx- Termination
= PN PN 1200 120
= SDA AN RX+ VaANE RX+ E;
] 1 ] 1
PFXZCBADTM1 SbB \ ".‘ ,'. RX- \ "-‘ .’. RX-
[ [
SG ' SG ' SG
Y Y l

\4

A

User-created cable

¢ The cable length must be 1000m or less.

NOTE I
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12J)
e 1:1 Connection

External Device side
RS-422/485
Communication
Terminal block

: Signal name | Termination
Display resistance
D1 RX+ 120Q 1/2W
DO
RX- %
+
PFXZLMCBRJR81 %
Tx-
GND
SG
e 1:n Connection
External Device side External Device side
Termination RS-422/485 RS-422/485
resistance Communication . Communication
220Q 1/2W Terminal block Sth-"d" Terminal block
oisp pi\ |Suaname | 77| Sonalname | iz
spay RX+ AL RX+  [2200 1/2W
7Y
1 1
RX- ; / \ RX- %
! |
Tx+ : b Tx+
PFXZLMCBRJR81 | Voo
Tx- \ Voo Tx-
“ \‘ I‘l
SG ) ‘\ H SG
NOTE I ¢ The cable length must be 200m or less.
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of
the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

6.1 Micro/Premium/Twido/Quantum/Momentum Series

[E====]) This address can be specified as system data area.

32
Device Bit Address Word Address bits Notes
Coil 000001 - 065536 000001 - 065521 e |
Discrete Input 100001 - 165536 100001 - 165521 (L/H 11
Input Register | - 300001 - 365536 or 157 ™2
HIL
) . 400001,00 - (ML
Holding Register 465536.15°3 400001 - 465536 n 1]

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
F""4.1 Setup Items in GP-Pro EX" (page 46)

*2  Write disable
*3  Anaccess method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device

Setting].
-Clear......co...... Lﬂ'j]
- Do not clear .... 400001,00 - 465536,15
6.2 FCN/FCJ Series
[==——=] This address can be specified as system data area.
. . 32
Device Bit Address Word Address bits Notes
Coil 000001 - 009984 000001 - 009969 e | | *2
Discrete Input 100001 - 109984 100001 - 109969 [L/H pored A BN
. 300001.00 - ] or 3
Input Register 309999 15 300001 - 309999 =15
HIL
. . 400001.00 -
Holding Register 409999.15 400001 - 409999 “ c19)

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device

Setting].

&"4.1 Setup Items in GP-Pro EX" (page 46)

*2  The device access range of the External Device is specified as 1 to 9999, that of the Display, however, as up to
9984, since the Display device is accessible in 16-bit units.

*3  Write disable
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6.3

Supported Function Code

Below is the list of Supported Function Code.

MODBUS SIO Master Driver

Function Code (Hex)

Description

FCO1 (0x01)

Reads the ON/OFF status of coils (0X references) in the slave.

FCO02 (0x02)

Reads the ON/OFF status of discrete inputs (1X references) in the slave.

FCO03 (0x03)

Reads the binary content of holding registers (4X references) in the slave.

FCO04 (0x04)

Reads the binary content of input registers (3X references) in the slave.

FCO5 (0X05)

Forces a single coil (OX references) to either ON or OFF

FCO06 (0X06)

Presets a value into a single holding register (4X references).

FC15 (OXOF)

Forces each coil (0X references) in a sequence of coils to either ON or OFF.

FC16 (0x10)

Presets values into a sequence of holding registers (4X references).

NOTE | * FC15/FC16 will be used for writing. In case if the connected controller do not support these
function codes, then FC05 / FC06 will be used.

6.4 IEC61131 address syntax
The following table gives the equivalences between the Modbus syntax and the IEC61131 syntax.
Modbus address syntax IEC61131syntax
. 0-based 1-based
Device
First Format First First
Format Range Range Range
element element element
. . | i=0to . i=0to i=1to
0, 0, 0,
Call 000001 +i 65535 000001 %Mi 65535 %MO00000 65536 %M00001
Discrete . |i=0to
Input 100001+i 65535 100001 - - - - -
Input register . | i=0to
(word) 300001 +i 65535 300001 - - - - -
Input register I=0to
(W%r | bi% 300001+i,j | 65535 | 300001,00 | - - ; - -
j=01to015

Holding . . .

- . |1=0to . | 1=0to i=1to

0 0, 0,
register 400001 +i 65535 400001 %MWi 65535 %MW00000 65536 %MWO00001
(word)
Holding i=0to 0 . |i=0to 0 Cli=lto 0
register 400001+i,j | 65535 400001,00 Q.MW" 65535 )/(o(l)\éI)WOOOOO. 65535 ﬁl:)/lalv 00001
(word bit) j=0to15 ! j=0t0 15 j=0 to15 |
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NOTE | * Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
« Please refer to the precautions on manual notation for icons in the table.

& "Manual Symbols and Terminology"

« The two areas 100000 and 300000 are not accessible with the IEC syntax.

« Once you change the project which you have setup Discrete Input Register to IEC 61131 Syntax,
the address will be undefined.
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

7.1 Micro/Premium/Twido/Quantum/Momentum Series

Device Code

Device Device Name Address Code
(HEX)
Coil 0 0080 Value of (word address - 1) divided by 16
Discrete Input 1 0081 Value of (word address - 1) divided by 16
. Value of word address from which 1 is
Input Register 3 0001 deducted
Holding Register 4 0000 Value of word address from which 1 is
deducted
7.2 FCN/FCJ Series
. , Device Code Address Code
Device Device Name
(HEX)
Coil 0 0080 Value of (word address - 1) divided by 16
Discrete Input 1 0081 Value of (word address - 1) divided by 16
. Value of word address from which 1 is
Input Register 3 0001 deducted
Holding Register 4 0000 Value of word address from which 1 is
deducted
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8 Error Messages
Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error
Occurrence Area)". Each description is shown below.
Item Description
No. Error No.

Device Name

Name of External Device where error occurs. Device name is a title of External Device set
with GP-Pro EX. (Initial value [PLCL1])

Error Message

Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

« IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
« Device address is displayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal[Hex]".

Display Examples of Error Messages
"RHAAOQ35: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE | * Refer to your External Device manual for details on received error codes.
« Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error
messages common to the driver.
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